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Chapter 1

Introduction

1.1 Motivation

Two important areas of research and science which have directly benefited from the use of thin films,

and specifically metallic films, are Microelectromechanical Systems (MEMS) and MEMS-based elec-

trical contacts. Metals such as Au, Ag, Pt and Rh are often deposited onto the MEMS structures

and offer great benefits in terms of increased electrical conductivity and mechanical reliability. How-

ever, little has been reported on how the nanomechanical properties of these contact films affect the

mechanical degradation and electrical performance of these devices. By obtaining an understand-

ing of the mechanical, structural and electrical properties of thin films, the optimum material can

be chosen and efforts focused toward improving the properties of the material in order to create a

system which utilizes the ideal combination of electrical and mechanical properties critical to a high

level of device performance.

1.2 Objective

The objective of this work is to investigate the modification of pure Au films so as to examine how

the material properties can be altered through the development of an Au-Si film. The strengthening

mechanisms resulting from the modification of the Au films will be examined as well as the effect

of the surface and subsurface material structure and properties on the mechanical and electrical

properties of pure Au and Au-Si thin films.
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1.3 Research plan

This work is a part of a collaboration between research groups at Oklahoma State University

(OSU), Massachusetts Institute of Technology (MIT) and the Center for Integrated Nanotechnolo-

gies (CINT) at Los Alamos National Laboratory (LANL) aimed at investigating high-performance

electrical contacts and the modification of thin film contacts for MEMS devices.

In this work, an investigation of a basic pure Au system was carried out to first examine the

effects of deposition rate, heat treatment and different adhesion layers on the film properties. Then,

an experimental study was completed to investigate the modification of pure Au films by the intro-

duction of Si so as to examine the changes in hardness, surface topography and resistivity on the

resulting film.

Atomic Force Microscopy (AFM), nanoindentation and four-point probe were utilized to in-

vestigate the surface topography, mechanical properties and resistivity of these films, respectively.

Furthermore, X-ray Diffraction (XRD) and Transmission Electron Microscopy (TEM) measurements

were performed to investigate the material crystallography and structure.
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Chapter 2

Background

The subject of thin metallic film research is an exciting area of science and technology which impacts

a broad range of industries and disciplines. A thin film can be characterized simply as a thin layer

of material, generally with a thickness of less than 1 µm. The interesting aspect of thin film science

is that it has existed as far back as 4,000 years ago to the Egyptians who used gold (Au) hammered

into thin films, some of which were only 300 nm in thickness, to adorn statues, coffins and royal

crowns. Today skilled craftsmen can create gold leaf with thicknesses of 100 - 500 nm and it

can be seen adding decorative touches to a wide range of items such as picture frames, furniture,

custom motorcycles and even chocolate. Gold leaf was one of the first metallic samples studied by

Transmission Electron Microscopy (TEM) [1,2].

Today thin films play a critical role in many high technology industries and scientific disciplines.

The use of thin films can be seen in applications such as microelectronics, optics and general high

performance coatings.

2.1 Selected studies utilizing Au thin films

MEMS switches utilizing metallic contacts often incorporate Au as a thin film contact material

due to its enhanced properties such as improved electrical conductivity, low resistivity and contact

resistance, corrosion resistance and ductility [3–7].

Numerous studies have been conducted on Au thin films and due to its prevalent use in MEMS

applications this section will focus on research that has been carried out on Au films used in electrical

contacts. Specific areas of focus in the literature have been wear [8], electrical properties such as

contact resistance [4,5,9–15] and resistivity [6], adhesion [5,10,12,15,16], thermal effects [11], contact
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failure [5, 11,17] and mechanical properties [6, 14,18–22].

When Au began to be incorporated as an electrical contact film, early studies focused primarily on

characterization of the electrical performance and robustness of the films during simulated operation.

One of the key issues in electrical contacts is obtaining a desirable relationship between the contact

force necessary for stable resistance and the lift-off force necessary to overcome any adhesion between

the contacts [10]. One of the earliest relevant studies in this area was conducted by Schimkat in

1998 [10]. Schimkat investigated the effects of contact forces in the range of 0.1 - 10 mN, on the

stability and adhesion of Au, Au-Ni alloy and Rh contact rivets. Very high and unstable resistances

were observed when the initial contact was established and very low contact forces were present.

A minimum force was necessary to obtain a significant reduction in the resistance and the contact

became stable as the force was increased. Similar trends in contact resistance and force were later

reported by Hyman and Mehregany [23]. Au was found to have the smallest minimum contact

force at 0.1 mN, at which stable contact was established and the resistance was less than 1 Ω.

The contact resistance Rc was also measured and found to relate to the contact force Fc by the

relationship Rc ∼ F
− 1

3
c , which for Au was less than 30 mΩ. Schimkat also noted that in order for

the contact to be reliable, a lift-off force must be applied which exceeds the force generated due to

adhesion between the two contacting surfaces. However, Au was found to have the highest lift-off

force at 2.7 mN compared with 0.3 mN for the Au-Ni alloy [10].

Consistent with the work by Schimkat, most electrical contact research up to the end of the 20th

century was mainly focused on establishment of the contact instead of the extended operation and

reliability [24]. A later study by Hyman and Mehregany [23], conducted on Au-plated Si substrates

in contact with Au-plated W probes, confirmed that the contact resistance is very high at low loads

and decreases and stabilizes as the force is increased. Contact resistances for Au films were found to

be between 70 - 120 mΩ for contact forces of 100 - 500 µN, respectively. It was also reported that the

electroplated Au, with a hardness of about 1 GPa, had annealed and softened causing Au material

transfer to the harder, sputtered Au anode, which had a hardness of about 3 GPa. In addition

to showing evidence for greater performance in contacts with harder deposited Au films , it was

hypothesized that the temperature at which the films annealed and softened could be related to the

deposition temperature. Hyman and Mehregany reported that annealing and softening occurred for

contact films subjected to temperatures greater than their deposition temperatures during contact

cycling. The sputtered Au film, deposited at a higher temperature than the electroplated Au, was not

expected to anneal and soften until operation temperatures exceeded the deposition temperature [23].

This would imply that electrical contacts containing Au films deposited by electron-beam evaporation
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(minimum evaporation temperature of 1132 ◦C [2]), such as those investigated in the present study,

would be able to withstand higher operation temperatures.

Although Au is often chosen due to its superior electrical properties, electrical contacts incor-

porating Au often experience failure as the soft Au deforms and causes the metal contact switches

to adhere to one another and remain stuck closed [4]. Additionally, the low hardness (1 - 2.3 GPa

for Au films previously reported in the literature [14, 21, 22]) and ductility of the Au films, leads

to deformation at the contact area of the two switch surfaces, which causes an increase in the con-

tact area and an initial reduction in contact resistance [14]. Besides causing device failure through

stiction between the contacts, the junctions of adhesion between the Au contacting asperities, also

known as microwelds, can shear leading to material transfer occurring between the contacts [17,25].

This can immediately lead to device failure, or the small microwelds can also break off forming wear

fragments which can further damage the surfaces [17,25] and lead to poor electrical performance.

The next section presents some of the methods which have been used to modify and improve the

material properties in Au and other thin film systems.

2.2 Improving Au film properties

Thin film modification techniques such as ion implantation, ion irradiation, the addition of various

alloying elements and precipitation hardening have all been seen to be an effective means to obtain

desired material properties. These methods allow the material to be tailored to individual needs

and adjusted to meet various applications. The use of thin film modification techniques in Au thin

film systems is presented below.

2.2.1 Ion implantation and ion irradiation of Au films

Ion implantation and ion irradiation involve creating a charged particle from an ion source and di-

recting and accelerating a focused beam of the ions onto the surface to be modified. The accelerated

ions dissipate energy by interacting with the target material. Defects are produced in the target ma-

terial, as a result of the ion-solid interaction as well as the presence of the implanted ions, generating

changes to the specimen’s microstructure and leading to changes in the material’s properties [26,27].

A large portion of reported work has been on studies of N implanted Au films, however the use

of other ion species has been investigated as well. One such early study was conducted by Robic et

al. [28] in which Au films evaporated onto Si substrates were implanted with He+, Ne+, Ar+, B+,

and Al+ ions at energies of 100 - 200 keV and fluences of 3 x 1017 ions/cm2. In this study, which
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appears to be one of the earliest focused on altering the material properties of Au by implantation,

the properties of the film including hardness, residual stress and wear were measured to understand

the effects of implantation. Knoop microhardness measurements of the films revealed a 35% relative

hardness increase in the Au films after implantation with B+ or Ne+ ions at high fluences. With

the exception of work focused on N implantation of Au films, there appears to have been little other

work involved with investigating the change in mechanical properties (such as hardness) as a result

of implantation.

Recently, ion implantation has been used to reduce the curvature in metallized MEMS cantilever

beams [29] and optical mirror devices [30]. In a study by Jin et al. [30], MEMS optical mirrors with

deposited Au films were implanted with 20 - 40 keV Si+ ions at fluences of 0.4-5 x 1016 ions/cm2.

It was reported that as the fluence was increased to about 0.8 x 1016 ions/cm2 the metallized

mirrors lost their initial curvature and became nearly flat. This was attributed to the increased

compressive stress in the Au film, brought on by the introduction of the implantation species into

the lattice structure of the Au. These compressive stresses induced by the implantation reduced the

specimen curvature by counterbalancing the tensile stresses present in the specimens after the initial

metallization. In a similar study by Kang et al. [29], MEMS microcantilever beams with deposited

Au films were implanted with He+ and N+
2 ions at energies of 40 - 50 keV and fluences of 1016 - 1017

ions/cm2 in order to reduce the residual stresses present in the beams leading to unwanted specimen

curvature. It was found that after implantation, the residual stresses in the films were reduced by

15 - 62% for the fluence range used. Similar to that previously discussed, the reduced curvature was

attributed to the induced compressive stress as a result of implantation.

The modification of the electrical properties and surface morphology of Au films as a result

of ion implantation has also been investigated. One such study was conducted by Ikeyama et al.

in 1994 [31] in which Au films deposited on Pyrex glass or MgO single crystal substrates were

implanted with Si+, Ni+ and Au+ ions at energies of 0.75 - 3 MeV and fluences of 5 x 1013 - 5 x 1016

ions/cm2. After implantation it was observed that a depression was left on the surface of the film

and increased in size with increasing fluence. Scanning Electron Microscopy (SEM) results indicated

that the surface became smoother after implantation and also that grain growth occurred. Artunc

et al. [32] also showed evidence for grain growth after implanting Au films with 125 keV Cr+ ions at

fluences ranging from 1 x 1014 - 5 x 1016 ions/cm2. The structure of the films was characterized by

TEM and Rutherford backscattering spectrometry (RBS); electrical measurements were conducted

using a standard four-point probe technique. RBS measurements indicated the formation of a Au-

Cr alloy at fluences less than 5 x 1016 ions/cm2 and ion induced mixing of both the Au and Cr+
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ion into the substrate at fluences above 5 x 1015 ions/cm2. TEM results indicated that the grain

size increased with increasing fluence and electron diffraction patterns indicated the formation of a

Au-Cr solid solution. Four-point probe measurements revealed that the resistivity doubled as the

fluence was increased from 1 x 1014 ions/cm2 - 1 x 1016 ions/cm2.

N is often used in ion implantation and when it interacts with a material surface the reaction can

produce metallic nitrides [33]. The benefits of N implantation of metallic films and the formation of

metallic nitrides are widely reported [33–40] and these newly formed metal nitrides are known to be

useful for a range of applications, and possess distinctive properties such as high hardness and high

melting temperatures, chemical stability and useful electronic properties [38,40].

N implantation has been utilized in Au and other metals such as Ag, Ti, Ta, Mo, W, Ni, Fe

and Cu [37–43]. One of the first reports of N implantation of Au was by Lancaster and Rabalais in

1979 [34] in which Au and several other thin metallic films were implanted with N+
2 ions at energies

ranging from 30 eV - 3 keV. In this work, they were unable to detect any N1s signals in the X-ray

Photoelectron Spectroscopy (XPS) measurements and proposed that this was due to either: 1.) not

enough N+
2 implanted to be detected or 2.) the lighter N was being preferentially sputtered rather

than the heavier Au atoms (Atomic mass: Au = 196.97 g/mol versus N = 14.007 g/mol). There

was also no N observed at low energies such as 50 eV (when sputtering rates are low) and it was

proposed that this was most likely due to either low sticking probability or low chemical reactivity.

In a later study, Anttila et al. [33] implanted 16 metals, including Au, with 300 keV N+
2 ions and

observed the resulting N concentration using RBS with a 2 MeV 4He+ ion beam. They also utilized

a micro-hardness tester and an optical microscope to observe the mechanical and surface properties.

Micro-hardness measurements revealed relative hardness increases of 1.0 for Au, Mo and Ag to as

high as 2.3 for Ti. In addition, the surface analysis revealed that blisters due to the N+
2 implantation

formed on many of the metal surfaces. While a N concentration of 18% was observed in Au films,

there was no confirmation of the formation of AuN. The failure to form AuN was attributed to the

high sputtering yield of the N, leading to a concentration that was too low to react with the target

metal. This claim was later argued by Zhou et al. [35] when they proposed that the average N

concentration was not a factor in the formation of a metal nitride but aspects such as structural

compatibility and compound growth kinetics were most likely the key.

The point made by Zhou et al. that the main influence in the formation of metal nitrides by

implantation is chemical compatibility was concluded and expanded further by Sanghera and Sullivan

in 1999 [37]. They proposed that two indications of the reactivity and the formation of a metal nitride

are: 1.) the difference in the electronegativity between the metal and N and 2.) how negative the heat
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of formation of the nitride is. The higher the difference in electronegativity between the metal and

N and the more negative the nitride’s heat of formation, the greater will be the chemical interaction

and driving force for the formation of the nitride. The difficulty of forming AuN could also be due

to its chemical inertness or that the N may be isolated to interstitials and then sputtered because

of its lighter mass [37].

Reported experimental results have demonstrated that implantation of metallic films with N+
2

ions can lead to an improvement in the material properties. In studies by Leech et al. [44, 45], N+
2

ions were implanted into various Au-based alloys and electroplated Pd thin films and the tribological

effects were studied. Micro-hardness measurements, utilizing a Knoop diamond indenter, showed

that hardness increased by 12 - 13% in the Au-based alloy. Contact resistance measurements revealed

a slight overall decrease in resistance of the Au films after implantation. There was also an observed

decrease in the coefficient of friction of the implanted films.

The first reported observation of AuN was by Siller et al. in 2002 [38]. In this study, using methods

similar to those used in N implantation of Cu, (110) single crystal Au was irradiated with 500 eV

and 2 keV N+
2 ions under ultra-high vacuum (UHV). The AuN formation was confirmed after XPS

revealed N1s peaks at a binding energy of about 396.6 eV, which was in the range of peaks observed

at 396.5 - 396.8 eV on N implanted (110) Cu. Later studies by the same group [39, 40] reported

similar binding energy peaks in the N1s spectra. In a study by Siller et al. in 2005 [40], AuN films

were created using both low energy reactive ion sputtering and plasma methods. Nanoindentation

measurements indicated that the hardness of the films increased by about 50% compared to un-

modified pure Au films. Four point probe measurements indicated that the contact resistance of the

films increased 82% from about 4 x 10−8 Ω-m to about 1 x 10−7 Ω-m. The group proposed that

previous work had failed to detect or produce AuN either because the ion energies were too high or

the sensitivity of the equipment was insufficient.

The evidence presented from the literature suggests the possibilities of using nitrogen implan-

tation to improve the physical and electrical properties of Au thin films. However, the lack of

verification for the production of AuN by means of implantation indicates that producing AuN films

is a very difficult process and thus was not pursued in this study.

The majority of studies on the modification of Au thin films by ion irradiation present in the

literature utilize Ar+ [46–52]. These studies have reported that Ar+ irradiation in Au thin films

leads to grain growth [50], increases in resistivity [46], sputtering of Au [46], mixing of Au with the

substrate material [47] and the formation of islands on the surface of the film [47, 48], all of which

would be detrimental to the performance of an Au coated electrical contact.
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Similar to the studies utilizing Ar+ for irradiation of Au films, those involving Xe+ ions were

principally focused on observing the Au surface morphology after irradiation and have reported

crater and hole formation [53, 54], sputtering of Au from the film surface and film erosion [55–57].

Again, surface changes such as these would have adverse effects on the performance of an electrical

contact film.

2.2.2 The modification of Au films through the addition of alloying ele-

ments

The low hardness of Au leads to increased wear and failure when used as a contact material [4]. One

method of improving the hardness of Au films is through the addition of alloying elements such as

Pt, Ag, Pd, Rh, Ru, [4,6], Co [58,59], Ni [10,12,59,60] and Cu [61]. Hard Au films consisting of Au

alloyed with 0.06 - 0.5 wt. % of either Co or Ni [58] are often deposited, through electroplating, onto

microrelays, circuit boards and electrical connectors [60]. Hard Au films typically have hardnesses

2 - 3 times that of soft Au. This increased hardness has been attributed to the reduction in grain

size and the Hall-Petch effect [60]. In addition to hardness, the electrical properties must also be

acceptable for the films to be used in electrical contact applications. In a study on the contact

resistance stability of hard Au thin films, Antler [58] found that Co-hardened Au (Au-Co alloy film)

exhibited a higher initial contact resistance than Au (roughly twice that of pure soft Au) due to

its increased hardness and resistivity. While Ni-hardened Au (Au-Ni alloy film) had roughly the

same increase in contact resistance, it was more thermally stable as the films were aged for up to

1000 hours at 200 ◦C. Later studies by Schimkat [10, 12] also investigated the electrical properties

of Ni-hardened Au and found that the contact resistance of the alloyed films increased from 15 -

60 mΩ while the adherence force (the force required to open the closed contact) was much lower

for the Ni-hardened Au film at 0.3 mN compared to 2.7 mN for the pure Au film. A recent study

by Togasaki et al. [60] investigated the mechanical and electrical properties of amorphous hard Au.

Knoop microhardness experiments indicated that amorphous Au-Ni alloy films possessed hardnesses

more than twice that of traditional Au-Co alloy films and more than 5 times the hardness of soft

Au films. It was also found that the Au-Ni alloy film had about the same contact resistance of

the Co-hardened film (2.21 mΩ and 2.16 mΩ for the amorphous Au-Ni film versus the Au-Co film,

respectively).

In addition to the modification of Au films by the addition of Co and Ni alloying elements,

there have been studies on Au films alloyed with other elements as well. Similar to the hard Au
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film discussed in the previous section, an electroplated Au-Cu alloy was recently investigated by

Jankowski et al. [61]. In this study, 10 µm thick films alloyed with 5 wt. % Cu were characterized

and found to possess a Vickers microhardness of 2.9 GPa. It was determined that, similar to

that reported by Togasaki et al. [60], the reduction in grain size was the dominate mechanism

responsible for the film hardening. Additional recent studies have been conducted by Coutu et

al. [4] and Lee et al. [6] involving a comparison of several Au alloy films used as electrical contact

materials for MEMS switches. In their first study [4], Au films alloyed with either Pt, Pd or Ag at

concentrations of 1 - 10 at. %, were developed by co-sputtering both Au and the alloying element

onto 3 in. Si wafers. XRD was performed on all films in order to determine the material composition

and crystal structure. The electrical properties (contact resistance and resistivity) of the films were

determined using the four-point probe method and the mechanical properties were measured using

nanoindentation. Of the various alloy films investigated, the Au-Pt thin film with approximately

6% Pt performed the best with a measured hardness and contact resistance of 2.19 GPa and 0.42

Ω, respectively, compared to the pure Au film properties of 1.77 GPa and 0.21 Ω for hardness and

contact resistance, respectively. The resistivity increased from 3.93 - 7.17 µΩ-cm for the pure Au

film versus the Au-6%Pt alloy film, respectively. In the second study by Lee et al. [6], Au films

were alloyed with either Pt, Rh or Ru at concentrations of 10 - 70 at. %. They were developed by

co-sputtering both Au and the alloying element onto Si wafers. Similar to the previous study, the

resistivity was determined using the four-point probe technique and the mechanical properties were

determined using nanoindentation. Nanoindentation measurements indicated hardness values, for

the 1500 nm thick pure Au, Au-30%Rh, Au-30%Ru, Au-10%Pt, Au-50%Pt films, of 0.81, 3.58, 6.69,

1.47, and 4.58 GPa, respectively. Four-point probe resistivity measurements of the films indicated

average values, for the 1500 nm thick pure Au, Au-30%Rh, Au-30%Ru, Au-10%Pt, Au-50%Pt films,

of 3.6, 58.8, 83.9, 15.2, and 43.3 µΩ-cm, respectively.

2.2.3 Precipitation hardening of thin films

Recently reported studies have shown an increased hardness in films containing uniformly dispersed,

immiscible particles. Recently, Radmilovic et al. [62] observed that co-evaporation of Al with up to

23 at. % of Si can increase the Al film hardness by as much as 400% . In their work, evenly dispersed

Si nanocrystals with sizes ranging from 10 - 20 nm were observed in Al films co-evaporated with a

Si content of 12 at. %. A refined Al grain structure and morphology were observed and attributed

to pinning of the grains caused by the Si phase. The improvement in the mechanical properties
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was attributed to Hall-Petch strengthening resulting from the refined Al grain structure and also to

Orowan strengthening from the Si particles inhibiting dislocation motion.

This increased hardness effect could be further improved by adding Ge along with Si, as discussed

by Hornbogen et al. [63], to create an order of magnitude finer dispersion of particles in Al alloy

films compared to those with Si alone . Mitlin et al. [64] attributed this effect to counteracting

volumetric strains in Al solid solutions leading to a dense distribution of Si-Ge solutes that converted

to diamond-cubic form once annealed. They also reported that the Si-Ge precipitates were more

equiaxed in addition to being finer than Si precipitates alone . The dense distribution of fine

precipitates has been reported to occur only when both Si and Ge are present and the addition of

simply Si or Ge results in overly-coarse precipitates [65]. However, the Si-Ge precipitates, while finer

than the Si or Ge particles, may still be too coarse to provide improved hardening [64,66].

Only a few studies have been found which utilize the benefits of precipitation hardening in Au

films. Recently, Ramirez and Saha [67] conducted experimental work on compositionally graded

Au-Co films with material content ranging from pure Au and increasing Co content up to pure

Co. A linear increase in the thin film hardness from 2 - 9 GPa was observed for the pure Au to

pure Co. Nelson-Fitzpatrick et al. [68] performed a similar study on Au-Ta thin films prepared by

co-sputtering Au and Ta to create pure Au films and Au-Ta films with increasing Ta content up to

a pure Ta film. Nanoindentation experiments conducted on the films showed the hardness increased

from about 2 GPa for the pure Au film up to about 11.5 GPa by the addition of up to 65 at. %

Ta. The increase in hardness was attributed to several mechanisms including grain size reduction,

precipitation hardening, the higher intrinsic hardness of the Ta and a phase change occuring in the

Ta at concentrations greater than 50 at. %. The grain size ranged from 68 - 30 nm for the pure Au

film to the 50 at. % Ta film. It was reported that the observed grain size reduction was due to Ta

particles pinning the Au grains and restricting grain growth, similar to that reported by Radmilovic

et al. [62].

While precipitate hardening has been shown to be ineffective in sputtered Al-Si and Al-Si-Ge

alloys due to coarse precipitates, the previously discussed work by Radmilovic et al. [62] showed

evidence that precipitation hardened Al-Si alloys can be effectively prepared using co-evaporation.

Additionally, the work by Ramirez and Saha [67] and Nelson-Fitzpatrick et al. [68] indicate that the

hardness of Au thin films can be enhanced by the use of precipitation hardening. Also, Al-Ge and

Al-Si alloys form simple binary eutectic systems [65] similar to Au-Si alloys providing evidence for

the feasibility of incorporating Si or Si-Ge precipitation hardening into Au thin films. Furthermore,

Au and Si are known to be almost completely immiscible in the solid state [69] suggesting that
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co-deposition of the two would result in the segregation of Si particles within the Au matrix leading

to a dispersion hardening mechanism similar to precipitation hardening reported in the previously

discussed studies. These prior studies suggest that mechanisms in addition to precipitation or

dispersion hardening such as grain size strengthening and the higher hardness of Si (reported to be

as high as 13 GPa [70]) could contribute to improving the hardness in Au thin films. These ideas

are further explored in the present study.

Some of the basic principles of dispersion hardening and the mechanisms which contribute to

hardening in films containing a uniform dispersion of immiscible particles are discussed next.

2.3 Dispersion hardening

Some of the typical methods used to strengthen and modify the material properties of Au thin films

have been discussed in the previous section. According to Martin [71], there are four main methods

in which the plastic deformation resistance of a metal may be raised: cold work, grain refinement,

solid solution strengthening and precipitation hardening. Dispersion hardening could be considered

an additional hardening mechanism.

Whereas precipitation hardening is most commonly performed by heating a material and initi-

ating precipitation of second phase particles from a supersaturated solid solution [71], the second

phase particles in a dispersion hardened material have very low solubility and are non-coherent with

the matrix material [72]. There are three classes that dispersed phases can be classified as: 1.)

hardening precipitates which have a size range of 1 - 100 nm; 2.) intermediate-sized dispersoids with

a size range of 100 nm - 1 µm; 3.) coarse residual particles with sizes larger than 1 µm [71].

In the present work, improving the mechanical properties of Au thin films by dispersion hard-

ening was pursued. A dispersion hardened material developed through the co-evaporation of two

almost completely immiscible materials, Au and Si was investigated. The goal is that the Si will

form uniformly dispersed and distributed particles within the polycrystalline Au matrix that will

strengthen the material by impeding dislocation motion.

2.3.1 Dislocation/particle interaction

Martin [71] discussed the interaction between a dislocation line and an array of particles. An overview

is presented below.

Consider the model shown in Figure 2.1. A dislocation attempting to pass a line of particles,

which are separated by a distance λ, is forced to bow out to a radius R, and results in a dislocation
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line tension T that is separated by an angle φ. The dislocation line tension is directly opposed by

the force F, which represents the strength of the particle. When the angle φ has reached a critical

value, the dislocation line can break past the particle array and continue propagating through the

material. At this point, the two forces can be related through the following equation

F = 2T cos
1
2
φ (2.1)

where the critical angle φ is known as the breaking angle and F and T are the previously defined

values.

For the case of a particle acting as an impenetrable barrier, the breaking angle goes to zero and

Eqn. (2.1) can be simplified to F = 2T .

Figure 2.1: Schematic showing a dislocation interacting with a line of particles.

After Reference [71].

2.3.2 Orowan strengthening

In 1948, Orowan [73] proposed that the yield stress of a dispersion hardened material can be deter-

mined by the shear stress required to bend an approaching dislocation line between two particles

with an average separation distance λ, shown in Figure 2.1 [72]. The applied shear stress τ , can be

directly related to the dislocation line tension through the following equation

τ = T
b

R
(2.2)

where b is the dislocation Burgers vector and R is the radius of the bowing dislocation. By observing

the geometry in Figure 2.1 it can be shown that λ = 2R sin θ and when substituted into Eqn. (2.2)

yields

τ =
2T sin θ

bλ
(2.3)

Using the relationship θ = 90◦ − 1/2φ and assuming that the breaking angle φ = 0, for an

13



impenetrable particle, Eqn. (2.3) for the shear stress becomes

τ =
F

bλ
(2.4)

As discussed above, as the force F increases due to the increased strength imposed by the un-

shearable particle, the breaking angle φ reaches zero and F becomes equal to twice the dislocation

line tension T. Therefore, by substituting this relationship into Eqn. (2.4), the shear stress now

becomes

τ =
2T

bλ
(2.5)

which gives the critical shear stress required for the dislocation line to pass the particles.

Equation (2.4) can be further re-arranged by assuming that the strain energy of the dislocation

can be written as

U =
Gb2

2
(2.6)

where U is the total strain energy, G is the shear modulus of the matrix and b is the Burgers vector

of the matrix [72]. The dislocation line tension T is assumed equal to the strain energy U, therefore

by substituting Eqn. (2.6) into (2.5) the stress required to move the dislocation line between the

particles is [72]

τ =
Gb

λ
(2.7)

Figure 2.2 shows the various steps, discussed by Orowan, as the dislocation line approaches,

intercepts and passes two particles. Step 1 shows the dislocation line approaching two particles due

to an applied stress. At Step 2, the dislocation line begins to bend into the gap between the two

particles and continues until a critical curvature has been reached (Step 3). As this stress is reached,

the line continues to move past the particles and eventually separates itself from the particle leaving

a dislocation line remaining around each particle (Step 4). After Step 4 the dislocation line can

continue to move through the material (Step 5) [72,73].

Once the process described above is complete, if a new dislocation line approaches, the process

repeats itself and another dislocation loop is left around the particle. Each subsequent dislocation

loop causes an increased shear stress required to pass the next dislocation line past the particles

causing the material to strain harden.

The most common expression used to calculate the increase in yield strength of a material, as

determined by the Orowan mechanism, is one later modified by Ashby in 1968 [72].

σOrowan =
0.13Gb

λ
ln

r

b
(2.8)
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Figure 2.2: The various steps (1-5) of a dislocation line interacting with two

particles due to an applied stress. After Reference [72].

where G, b and λ are the previously defined values and r is the average spherical particle radius. To

obtain Eqn. (2.8), Ashby made the assumption that the Orowan stress was related to the average

stress required to move a dislocation line between an array of particles, τ̄ by [74]

σOrowan = (1/1.18)τ̄ (2.9)

where the average stress τ̄ represents a modification to Eqn. (2.7), made by assuming a more com-

plicated relationship between the dislocation line tension and the strain energy, given as [74]

τ̄ =
Gb

2πλ
ln

r

b
(2.10)

Equation (2.8) estimates the increase in yield stress of a material resulting from the presence of

a uniform dispersion of non-shearable particles. The hardness of a material can be estimated to be 3

times the yield strength [25] and therefore the hardness increase of the material due to the Orowan

mechanism can be determined through the modification of Eqn. (2.8) to obtain

HOrowan = 3σOrowan (2.11)

where HOrowan is the predicted hardness increase. A similar relationship between the material

hardness and the Orowan strength has been reported for Al2O3 reinforced Ni films [75].
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2.4 Hardening by reduction in grain size

Grain refinement is one of the mechanisms in which the plastic deformation resistance of a metal

can be raised [71]. Several studies have been discussed earlier which observed an increase in the thin

film hardness as a result of the reduction in grain size [60–62, 68]. Additionally, researchers have

reported a restricted grain growth resulting from grain pinning due to the presence of a uniform

dispersion of particles [62,68].

When plastic deformation occurs in a polycrystalline material, dislocation motion is impeded

by grain boundaries. Grain boundaries typically impede dislocation motion by either causing the

dislocation to alter its direction of motion as it travels from one grain to another at a different

orientation or due to a discontinuity of slip planes between the two adjacent grains [76].

A material with a smaller grain size is harder than one with larger grains because the fine-grained

material possesses a greater total grain boundary area to act as a barrier to dislocation motion [76].

The Hall-Petch relationship states that the yield stress of a material is inversely proportional to the

grain size through the well known equation

σ0 = σi + k D−1/2 (2.12)

where σ0 is the material’s yield stress, σi is known as the “friction stress” which represents the overall

resistance of the lattice to dislocation motion, k is the “locking parameter” which is a constant that

represents the hardening contribution of the grain boundaries and D is the grain diameter [72].

2.5 Nanoindentation

2.5.1 Analysis of experimental data

The analysis of the indentation experimental data was performed according to the procedure devel-

oped by Oliver and Pharr [77] which has its roots in the early work by Hertz in which a method was

developed to analyze the contact between a rigid sphere and a flat surface [78]. The experimental

values used in the analysis are shown in Figure 2.3.

Figure 2.3(a) shows a schematic cross-section of the geometry produced as the indenter is loaded

and unloaded onto the specimen surface. The load is applied to a maximum of Pmax and a maximum

depth of ht, shown in both (a) and (b). During the loading, the total displacement ht can be written

as

ht = hc + hs or ht = he + hf (2.13)
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Figure 2.3: (a) Schematic of indenter and sample surface geometry for a Berkovich

indenter. (b) Load versus displacement curve for the full loading and unloading.

Variables are defined in the text. After Reference [78].

where the contact depth hc is the distance that the indenter maintains contact with the surface, hs

is the displacement of the surface at the outer contacting edge of the indenter, he is the displacement

due to elastic deformation of the surface and hf is the final depth of the impression when the indenter

is completely withdrawn. Figure 2.3(b) shows the respective load versus displacement curve for the

indentation and shows where the various displacements are located relative to the curve. This curve

contains the necessary experimental data needed to obtain the hardness and elastic modulus. The

parameters of most interest, which will be used to extract material properties, from the curve of

Figure 2.3(b) are the maximum load Pmax, the slope of the unloading portion of the curve dP/dh,

also known as the contact stiffness of the material S, the maximum displacement at peak load ht,

and the contact depth hc.

The experimental analysis begins by observing the early work by Tabor [79] in which load and

displacement indentation methods were utilized to obtain the mechanical properties of materials.

Tabor developed an equation to effectively account for the non-rigid behavior of the indenter and its

effect on the load-displacement behavior and determine a reduced elastic modulus Er of the material

investigated. It can be defined as
1

Er
=

1− ν2

E
+

1− ν2
i

Ei
(2.14)

where E and ν are the elastic modulus and Poisson’s ratio for the sample investigated, respectively,
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and Ei and νi are the same material properties for the indenter. The reduced elastic modulus can

be found by using the equation for the contact stiffness of the material S, developed by Bulychev,

Alekhin, and Shorshorov in the 1970s [80]

S =
dP

dh
=

2√
π

Er

√
A (2.15)

where S = dP/dh is the experimentally measured stiffness, or slope, obtained from the unloading

portion of the curve in Figure 2.3(b), Er is the reduced elastic modulus and A is the projected area

of the elastic contact.

The projected area of contact A is also used to determine the hardness and can be found by

using the geometry of the indenter and the contact depth hc, obtained from the load-displacement

curve. For a Berkovich indenter, the equation for the area of the indenter is

A(hc) = 24.5h2
c + C1h

1
c + C2h

1/2
c + C3h

1/4
c + . . . + C8h

1/128
c (2.16)

where the first term 24.5h2
c , is the area function for a perfect Berkovich indenter and the remaining

terms are added to take into account the imperfect nature and blunting of the indenter tip. Using

this along with the stiffness obtained from the curve, the elastic modulus can be obtained from

Eqn. (2.15). The hardness of the material can be evaluated by using Eqn. (2.16) along with the

maximum load Pmax, in the following equation

H =
Pmax

A
(2.17)

where H is the indentation hardness of the material.

2.6 Four-Point Probe

The four-point probe method is a basic technique used for measuring the electrical sheet resistance

and resistivity of a film. It consists of four linear, metallic probes which contact the metallic surface

in order to make an electrical connection. The instrument operates by having a current carried

through two outer pins while the drop in voltage VA, is measured between the two inner probes [81]

as shown in Figure 2.4.

In obtaining the resistance, there can be effects arising from specimen geometry which can

interfere with the measurements, such as variation in tip spacing or location near specimen edges

[81]. This can be accounted for by utilizing a dual configuration which involves taking a second

resistance measurement using an alternate probe configuration as shown in Figure 2.4. In this
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configuration, current is passed through the first and third pins while the second and fourth pin

record the corresponding voltage drop VB .

Figure 2.4: Standard and alternate instrument layout for sheet resistance mea-

surement using the four-point probe method [81].

Use of the dual configuration technique allows for the correction of measuring inconsistencies due

to the geometry [81]. Once the voltage drop is obtained, the sheet resistance or sheet resistivity Rs,

in units of Ω or more commonly Ω/square can easily be obtained from the following

Rs =

 4.532 ·RA

5.710 ·RB

(2.18)

where RA = VA

I and RB = VB

I and the constants, 4.532 and 5.710 represent geometrical correction

factors [82]. Once the sheet resistance is determined and the thickness of the film is known, the bulk

resistivity ρ, in units of Ω-cm, can be determined as

Rs =
ρ(Ω− cm)

t(cm)
(2.19)

To minimize the uncertainty of the measurement, a minimum contact resistance between the

probes and the specimen surface should be maintained. High contact resistance can be avoided by

removing any thick oxide layers which may be present on the surface and using clean probes which

are free from contamination. Also, probes that are relatively sharp along with increased load can

break through an oxide layer and contact a more conductive layer. Also, there should be minimum

current leakage across the surface or across a film layer boundary. This can be achieved by preparing

a clean surface for measurements [81].
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Chapter 3

Experimental

3.1 Specimen preparation

Polycrystalline Au films prepared at MIT were used for the initial Au baseline studies. Single crystal

(100) Si with a 200 nm thick thermally grown oxide layer was used as the substrate. For the first

study, a Ti adhesion layer, approximately 10 nm thick, followed by a polycrystalline Au film, with

a thickness of 700 nm, was deposited using a commercial electron-beam evaporator. The coated

Si wafers (6 in.) were subsequently cleaved to produce individual specimens. The Au films were

deposited at depositions rates of 1.5, 3 and 4.5 Å/s. In the second study, two sets of Au films,

one with a 20 nm Ti adhesion layer and one with a 20 nm Cr adhesion layer were prepared using

a deposition rate of 3 Å/s. To investigate the effect of heat treatment, specimens with a Ti or Cr

adhesion layer were also annealed at 100 ◦C for 1 hr in a N2 environment. The annealing temperature

was chosen to enhance adhesion between the Au film and the Ti or Cr adhesion layers.

For the expanded Au film studies, specimens were prepared at LANL. Au-Si films were deposited

by the co-evaporation of Au and Si onto (100) single crystal Si substrates using a commercial electron

beam evaporator operating at room temperature with a base pressure of approximately 2 - 4 x 10−7

Torr. Prior to co-evaporation, a 10 nm thick Ti adhesion layer was deposited onto the substrate.

The Au and Si were co-deposited at a combined rate of 10 Å/s to produce composite films with

thicknesses of approximately 1000 nm and with nominal Si concentrations of approximately 2, 5,

15, and 25 at. %. Pure Au films with thicknesses of approximately 1000 nm were also prepared to

serve as control specimens. Two sets of specimens were used for the experiments. To investigate the

effect of heat treatment, selected specimens with Si concentrations of 5, 15 and 25 at. % from the

first set were annealed at 300 ◦C in vacuum for 1 hour. The heat treatment temperature was based
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upon a recomendation by the group responsible for film preparation. RBS and Particle Induced

X-ray Emission (PIXE) were also performed at LANL to determine the actual composition present

in the first and second set of specimens, respectively. For the first set of specimens, the actual Si

concentration could not be measured from the RBS data due to Si signal overlap between the Si and

low energy Au signals resulting from multiple scattering and possible non-uniform Si distribution.

Therefore, these specimens will be referenced by their nominal Si concentrations. Si concentrations

for the second specimen set were found to be 2.5, 6, 13 and 21 at. % for the nominal concentrations

of 2, 5, 15 and 25 at. %, respectively.

3.2 Nanoindentation and Atomic Force Microscopy

Nanoindentation experiments were conducted using a commercially available, load-controlled nanoin-

denter (TriboScope Nanomechanical Test System R© manufactured by Hysitron, Inc.) interfaced with

an AFM (diDimension R© 3100 manufactured by Veeco, Inc.).

Prior to the performing of all nanoindentation experiments, the AFM was used to measure the

local surface topography and determine the roughness (Ra, Rq, Rz) over a 1 µm x 1 µm scan area.

A Berkovich diamond indenter (E = 1141 GPa, ν = 0.07 [83]) was used for all nanoindentation

experiments. The Berkovich indenter has a three-sided pyramidal type geometry which consists of

a 65.3◦ face angle, allowing for the same projected area-to-depth ratio as a Vickers indenter, and a

tip radius on the order of 50 - 100 nm. [78]. The specimen was placed in the instrument’s thermal

enclosure and the specimen, indenter and instrument were allowed to thermally equilibrate for 10 -

12 hours prior to beginning the experiments. Before each indentation, the local surface topography

was measured, and the thermal drift rate was measured over a 5 second interval to confirm that it

was less than 0.1 nm/sec. For each indentation, the load pattern shown in Figure 3.1 was used. The

loading sequence consisted of a 30 second load application up to the peak load, a 60 second hold at

peak load to account for creep in the material, followed by a 10 second unloading to 10% of the peak

load and a 60 second hold to allow for the measurement of the system’s thermal drift and finally a

2 second unloading to zero load. A typical load displacement curve is shown in Figure 3.2

The instrument’s compliance and the area function of the Berkovich indenter were determined

prior to the experiments by performing indentations upon aluminum and fused silica according to

the procedure developed by Oliver and Pharr [77]. A description of the procedure followed can

be found in [84]. Indentations were performed to minimum contact depths of at least 20 times

the arithmetic mean roughness (20 x Ra), according to the standards set forth by the International
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Figure 3.1: Load pattern used for all indentation experiments.

Figure 3.2: Typical load-displacement curve for the load pattern shown in Fig-

ure 3.1, obtained for the Au/2 at. % Si film.
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Organization for Standardization (ISO) [85]. On some cases, these specifications had to be slightly

modified, e.g., minimum contact depth of at least 5-10 xRa, to incorporate for the increased surface

roughness measured by AFM. For most indentations performed, the maximum normalized contact

depth used was 10% to avoid the influence of the substrate.

After performing each indentation, the measured load versus displacement data was analyzed

using the computer program, Indentation Data Analyzer (IDA), developed by M. Klopfstein [86].

From this software, the measured hardness H, reduced elastic modulus Er, contact depth hc and

material stiffness S, were determined according to the method of Oliver and Pharr [77]. The software

also determined the drift rate from the 60 s hold period at 10% of the peak load and the measured

load and displacement data were corrected. A total of 5 measurements were conducted for each in-

dentation load and an example of the repeatability is shown in Figure 3.3. The procedures described

above are discussed in further detail in Appendix B.

Figure 3.3: Load-displacement plot showing an example of the repeatability for 5

measurements conducted at a given load.

3.3 Four-Point Probe

Four-point probe measurements were conducted using a commercially available four-point resistivity

probe instrument (FPP-5000 manufactured by Veeco, Inc.). The FPP-5000 simplifies measurement
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of the electrical properties of materials by having the electronics and probe configuration contained

in a single instrument. The instrument is capable of measuring the material resistance V/I in units

of Ω, sheet resistance in units of Ω/square, resistivity in units of Ω-cm and thickness in units of 10−3

in. or µm. An accuracy of 0.5% is achievable on all measurements in the resistance range of 5 mΩ -

5 kΩ [87].

The probe apparatus was fixed to the instrument and set at a constant force (the probe pressure

was pre-adjusted on the instrument) and the measurement was made by pressing the wafer onto the

probes. This setup eliminated variations in force due to the operator or the specimen thickness. The

probes used for the measurements were placed in a standard configuration, as shown in Figure 2.4,

and had a spacing of approximately 1.6 mm. The instrument automatically applies a geometric

correction factor of 4.53 which can be multiplied further by an additional correction based on the

shape of the specimen and probe spacing [87]. For the results in this work, additional geometric

correction factors were applied ranging from 0.765 - 0.998 which varied depending upon the shape

and dimensions of the specimen [88]. Correction factors for a rectangular specimen geometry were

based upon the ratio of the specimen dimensions and the ratio of the smaller specimen dimension to

the probe spacing, and correction factors for a quarter wafer specimen geometry were based on the

ratio of the distance from specimen edge and the probes to the probe spacing [88]. The resistivity

measurements were conducted by inputing the film thickness and geometric correction factor into

the instrument, placing the specimen into the wafer holder with the backing plate onto the wafer

and then simply lowering the wafer onto the probe tips. The instrument automatically measured the

film resistivity each time the specimen was lowered and contacted the probe tips. For each specimen,

the measured resistivity was obtained from an average of four measurements which were conducted

by rotating the wafer holder roughly 90◦ after each measurement. A more detailed procedure on the

four-point probe measurements is given in Appendix C.

3.4 Supporting characterization techniques

3.4.1 Transmission Electron Microscopy

In order to investigate the material structure of the Au-Si specimens, TEM specimens were prepared

and subsequently characterized at LANL. The specimens were prepared by co-evaporation of the

Au-Si thin films (≈ 30 - 50 nm), with a nominal Si concentration of 25 at. %, deposited on NaCl.

The films were then floated off of the NaCl substrates onto TEM grids for characterization.
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3.4.2 X-ray Diffraction

XRD measurements were conducted in the OSU Department of Chemistry using a commercially

available X-ray Powder Diffractometer (D8 Advance R© manufactured by Bruker AXS, Inc.). The

instrument was operated at a voltage and current of 40 kV and 30 mA, respectively, and CuKα1

radiation with a wavelength, λ = 1.541 Å was used as the x-ray source.

The measurements were conducted using a θ−2θ scan with the specimen mounted in a reflection

geometry as shown in Figure 3.4. The angles θ and 2θ represent the angle between the x-ray

source and the specimen, and the angle between the projection of the x-ray source and the detector,

respectively. The specimen is placed onto the specimen holder which is mounted to the goniometer.

The x-ray source and detector are mounted onto the outer groove of the goniometer which allows

for a full 360◦ rotation [89] with a maximum usable 2θ range of -110◦ to 168◦, maximum angular

speed of 30◦/s and capable of angular increments as small as 0.0001◦ [90].

Figure 3.4: Schematic showing the main setup of the x-ray diffractometer for

performing the θ − 2θ scan with the specimen mounted in a reflection geometry.

After Reference [91].

Consider a beam of x-rays, generated by the instrument’s radiation source, defined and collimated

through a series of slits [89], incident on the specimen surface at an angle θ, as shown in Figure 3.5.

If the incident beam is diffracted off of the material’s upper plane of atoms and from the lower

plane, at a distance of d below, the beam diffracted from the lower plane travels a greater distance

causing the effective path difference between the two beams to be equal to 2d sinθ [89]. Constructive

interference occurs when both x-rays are in phase and the path difference becomes a multiple of the
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x-ray wavelength λ, leading to Bragg’s Law which can be written as

2d sinθ = nλ (3.1)

where d is the interplanar spacing, θ is the angle of the incident x-ray beam and the specimen, n

= 1, 2, 3 . . . , and λ is the wavelength of the x-ray source. Most often in XRD, n = 1 since higher

order diffractions are typically weak [92]. The diffracted beam is then passed through a series of

additional slits and the Kα radiation is isolated through the monochromator and the intensity of

the beam is measured by the detector.

Figure 3.5: Schematic showing the diffraction of an incident x-ray beam with the

upper two crystal lattice planes separated by an interplanar distance d. After

Reference [92].

The measured data is processed by the instrument’s software and a plot of the detected x-ray

intensity versus the angle 2θ is generated which shows a pattern of the diffraction peaks generated

from the measured material. The peaks can be identified by comparison with known material

reference data using the Powder Diffraction File (PDF). The PDF database was created and is

managed by The Joint Committee on Powder Diffraction Standards (JCPDS), established in 1969

and later became known under its present name, the International Centre for Diffraction Data

(ICDD) [89]. The latest software by the ICDD, the PDF-4+ 2007 with DDView+ and PDF-2

Release 2007 with DDView+ contain diffraction pattern entries on 272,232 and 199,574 materials,

respectively [93]. For this work, the peaks were identified through access to the ICDD PDF either

through the diffractometer software or using the PDF-2 Release 2007 with DDView+ software.

The material grain size was measured from the broadening of the diffraction peaks using the

software Win-Crysize installed on the instrument’s computer. The software determines the grain
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size by analyzing data which has been processed using a profile-fitting program and corrected to

account for instrumental line broadening effects using a standard Pb reference material.
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Chapter 4

Results and Discussion

4.1 Polycrystalline Au film baseline studies

4.1.1 Variable deposition rate

Surface Topography

Prior to investigation of the Au film mechanical properties by nanoindentation the topography of the

film was measured by AFM. Figure 4.1 shows 1 µm x 1 µm AFM images of the surface topography for

the Au films deposited at rates of 1.5, 3 and 4.5 Å/s. The surfaces of the film show small, uniformly

sized nodules which have been previously reported for electron-beam evaporated Au films [94, 95].

It has been reported that each Au grain can consist of several nodules [94] and that factors such

as the substrate temperature, deposition rate and thickness of the adhesion layer can influence the

nodule size [96]. The surface of the 1.5 Å/s film varies slightly from the other films having larger

nodules present on the surface. The surface roughness for the films was approximately 4 - 5 nm Ra

over the 1 µm2 area with values for individual films given in Table 4.1. Each value for the surface

roughness represents the average of 3 measurements.

Mechanical Properties

Film hardness and elastic modulus as a function of the contact depth hc, normalized to the thick-

ness of the film, were determined from the measured nanoindentation data and are shown in Fig-

ures 4.3 and 4.4. The data represent the average of five measurements and the error bars correspond

to the maximum and minimum values obtained. No material pile-up was observed for the Au films

at a normalized contact depth of about 0.10, as seen in an indentation profile shown in Figure 4.2.
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Figure 4.1: AFM image (1 µm x 1 µm scan size) showing the topography of Au

films deposited at a deposition rates of (a) 1.5 Å/s, (b) 3 Å/s, and (c) 4.5 Å/s.

Specimen Roughness

Ra (nm) Rq (nm) Rz (nm)

Pure Au - 1.5 Å/s 4.8 5.8 35

Pure Au - 3.0 Å/s 4.6 3.7 30

Pure Au - 4.5 Å/s 4.1 5.0 32

Table 4.1: Average roughness values for pure Au films evaporated at varying

deposition rates.
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Figure 4.2: Image of the profile of an indentation, conducted on the pure Au film

deposited at 1.5 Å/s at a normalized contact depth of about 0.10, showing the

lack of material pile-up.

The hardness was measured over the normalized contact depth range of 0.1 - 0.5 (corresponding

to contact depths of 70 - 350 nm) and was found to be 1 GPa to ∼ 1.5 GPa for all films. The

range of hardness values is consistent with the values of 1 - 2.3 GPa for Au films previously reported

in the literature [14, 21, 22]. The hardness is shown to be about the same for the 3 Å/s and 4.5

Å/s deposition rates and is slightly higher for the 1.5 Å/s rate, at a normalized contact depth of

greater than 0.2. It has been reported that larger initial grain sizes form during the microstructural

evolution of polycrystalline films deposited at lower deposition rates [97]. This is consistent with the

Au nodular size observed in the AFM images. The higher measured hardness for the film with the

larger nodules is inconsistent with the Hall-Petch relationship between hardness and grain size [72].

However, a clear relationship between nodule size and hardness can not be established since the

relationship between nodule and grain size is currently unclear. The hardness is seen to increase at

normalized contact depths of greater than 0.2, indicating the effect of the underlying Si substrate.

This is consistent with the work by Xu and Rowcliffe [98] and Cao et al. [22] who have shown that

for Au films, the substrate effect is minimized at normalized penetration depths of less than 0.2.

Nanoindentation was performed on (100) Si to investigate the properties of the substrate and

the hardness was found to be approximately 9.6 GPa over a contact depth range of about 20 - 150

nm. The hardness of (100) Si has been reported in the literature to be as high as 13 GPa [70].

The elastic modulus was determined over the same depth range as the hardness and varied

from approximately 80 - 130 GPa, increasing with increased normalized contact depth. The values
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obtained for the elastic modulus are consistent with those reported in the literature of 77 - 115

GPa for Au films [21, 99–102]. The elastic modulus of the Si substrate was also measured by

nanoindentation and found to be approximately 148 GPa. The elastic modulus values obtained for

the Au films at normalized depths greater than 0.2 can be seen to approach this value in Figure 4.4.

Elastic modulus values for (100) Si have been reported to range from 168 GPa [103] to 180 GPa [70]

and are consistent with the value of 158 GPa measured for the (100) Si substrate at a contact depth

of about 20 nm.

Figure 4.3: The effect of deposition rate on the hardness of Au thin films.

4.1.2 The effect of the adhesion layer and heat treatment

Surface topography

Similar to the previous specimen set, the surface topography was measured by AFM prior to perform-

ing nanoindentation. Figures 4.5 and 4.6 show 1 µm x 1 µm AFM images of the surface topography

of both as-deposited and annealed Au films deposited on Ti or Cr adhesion layers. The surface

roughness for the films, given in Table 4.2, was found to be approximately 2.5 - 3.5 nm Ra over the

1 µm2 area. Each value for the surface roughness represents the average of 3 measurements. For

the Ti adhesion layer specimens, the roughness decreased from 3 - 2.5 nm Ra as a result of the heat

treatment, while the roughness of the Cr adhesion layer specimens increased from 3.0 - 3.5 nm Ra
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Figure 4.4: The effect of deposition rate on the elastic modulus of Au thin films.

after annealing. Figure 4.6 shows a change in the surface structure after heat treatment of the film

with the Cr adhesion layer. Figure 4.7 shows a larger, 10 µm x 10 µm AFM scan of the surface.

A plausible explanation for the surface cracks observed for this film could be due to diffusion of Cr

toward the Au film surface, which has been reported for annealed Au films [96,104,105].

Specimen Roughness

Ra (nm) Rq (nm) Rz (nm)

Au/Ti/SiO2/Si - Annealed 2.5 3.1 20

Au/Ti/SiO2/Si 3.0 3.7 23

Au/Cr/SiO2/Si - Annealed 3.5 4.6 25

Au/Cr/SiO2/Si 3.0 3.7 22

Table 4.2: Average roughness values for as-deposited and annealed pure Au films

deposited on Ti or Cr adhesion layers.

Mechanical properties

Figures 4.10 and 4.12 show the hardness and elastic modulus as a function of the contact depth

hc, normalized to the thickness of the film. The data represent the average of five measurements

32



Figure 4.5: AFM images (1 µm x 1 µm scan size) showing the topography of (a)

as-deposited and (b) annealed Au films deposited with Ti adhesion layers.

Figure 4.6: AFM images (1 µm x 1 µm scan size) showing the topography of (a)

as-deposited and (b) annealed Au films deposited with Cr adhesion layers.

33



Figure 4.7: AFM image (10 µm x 10 µm scan size) showing cracks present on the

surface of the annealed Au film deposited with a Cr adhesion layers.

and the error bars shown represent the maximum and minimum values obtained. Hardness ranged

from 0.9 - 1.9 GPa and was seen to decrease with increasing normalized contact depth up to about

0.2. This is consistent with the indentation size effect, where the hardness is observed to increase at

distances closer to the surface [106–109]. The effect is based on arguments from the strain gradient

plasticity theory as discussed by Fleck et al. [106].

The indentation size effect can be seen in Figure 4.11 showing hardness of the annealed Au

film with an underlying Cr adhesion layer at normalized contact depths up to 0.5. The hardness

is seen to increase at normalized contact depths greater than 0.2 due to the increased influence

of the underlying Si substrate, as expected. The increase in the error bars seen at lower depths

could be due to the surface roughness. The minimum contact depth had to be modified to at least

10 xRa to account for the increased surface roughness and avoid the influence of the substrate. The

hardness values for this second set of films are also consistent with those previously reported in the

literature [14, 21, 22]. However, recognizing the variations associated with the measurements, no

significant effect of the adhesion layer and heat treatment on the hardness could be identified.

The elastic modulus was determined over the same depth range as the hardness and varied

from 70 - 100 GPa, increasing with increased normalized contact depth. The values obtained for

the elastic modulus are consistent with those reported in the literature of 77 - 115 GPa for Au
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films [21, 99–102]. The increased influence of the Si substrate was also evident by the increase in

elastic modulus at larger depths. Similar to the hardness measurements, no effect of the adhesion

layer and heat treatment on the elastic modulus could be identified.

A sudden increase in penetration depth at a given load, commonly known as “pop-in”, was

observed for both as-deposited and annealed Au films as shown in load-displacement curves given

in Figures 4.8 and 4.9. Pop-in in both as-deposited and annealed Au films has previously been

observed by Miller et al. [94]. It has been reported that this effect can commonly occur either due

to the sudden nucleation of dislocations at the beginning stages of plasticity or as the surface oxide

layer is penetrated by the indenter [110]. Pop-in events were not observed for the other Au films

presented in this study and the cause of this is currently unclear.

Figure 4.8: Load versus displacement curve for the as-deposited Au film with a

Cr adhesion layer. A pop-in event was observed at a load of about 20 µN.

Electrical Properties

Four-point probe measurements were conducted on all films and values measured for the resistivity

are shown in Table 4.3. The resistivity of the Ti adhesion layer specimens is consistent with the

value of 2.35 µΩ-cm reported for bulk Au [111]. The increased resistivity measured for the annealed

Cr adhesion layer specimen could be affected by the diffusion of Cr into the Au film, as discussed

earlier, which has been reported to lead to an increase in resistivity in Au films [96, 104, 105]. The
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Figure 4.9: Load versus displacement curve for the annealed Au film with a Ti

adhesion layer. A pop-in event was observed at a load of about 20 µN.

Figure 4.10: The effect of heat treatment and adhesion layer on the hardness of

Au thin films.
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Figure 4.11: Evidence of the indentation size effect in annealed Au films with an

underlying Cr adhesion layer.

Figure 4.12: The effect of heat treatment and adhesion layer on the elastic modulus

of Au thin films.
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cause of the increased resistivity measured in the as-deposited pure Au film with Cr adhesion layer

is unclear. Au thin film resistivity values as high as 5.3 µΩ-cm have been reported by Artunc et

al. [32], who attributed the higher values to grain boundary scattering .

Specimen Resistivity (µΩ-cm) Std. Dev. (µΩ-cm)

Au/Ti/SiO2/Si - Annealed 2.36 0.2

Au/Ti/SiO2/Si 2.24 0.3

Au/Cr/SiO2/Si - Annealed 4.36 0.4

Au/Cr/SiO2/Si 3.39 0.01

Table 4.3: Average resistivity values for as-deposited and heat treated pure Au

films deposited on Ti or Cr adhesion layers.

4.2 Au-Si films

4.2.1 Initial shakedown experiments investigating the effect of Si addition

and heat treatment

Surface topography

Figures 4.13 - 4.15 show AFM images of the surface topography of as-deposited and annealed Au

films co-evaporated with 5, 15, or 25 at. % Si. AFM images of later prepared pure Au and Au films

co-evaporated with 2 at. % Si are shown in Figure 4.16. The surface roughness for the films is given

in Table 4.4. Each value for the surface roughness represents the average of 3 measurements. Heat

treatment was not performed on the pure Au and Au/2 at. % Si films and will be further discussed

in the next section. The surface roughness was slightly higher than the values measured on the

initial Au baseline films. Furthermore, unusual peaks and craters were observed on all film surfaces

during the AFM measurements. Observation using an optical microscope indicated that there was

contamination on the film surfaces. Optical images of two typical surfaces are shown in Figure 4.17.

Experiments performed at LANL determined that the contamination was caused by the graphite

crucible used to contain the deposition materials during the evaporation process. It was reported

that after observing the contaminated wafer with SEM, the same defects were found to be present

on the sides of the graphite crucible. The problem was resolved when the graphite crucible was

replaced with one made from W which was used to prepare future specimens.
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Figure 4.13: AFM images (1 µm x 1 µm scan size) showing the topography of (a)

as-deposited and (b) annealed Au films co-evaporated with 5 at. % Si.

Figure 4.14: AFM images (1 µm x 1 µm scan size) showing the topography of (a)

as-deposited and (b) annealed Au films co-evaporated with 15 at. % Si.

39



Figure 4.15: AFM images (1 µm x 1 µm scan size) showing the topography of (a)

as-deposited and (b) annealed Au films co-evaporated with 25 at. % Si.

Figure 4.16: AFM images (1 µm x 1 µm scan size) showing the topography of (a)

pure Au and (b) Au co-evaporated with 2 at. % Si.
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Specimen Roughness

Ra (nm) Rq (nm) Rz (nm)

Pure Au 2.8 3.5 22

Au/2 at. % Si 4.4 5.9 38

Au/5 at. % Si 5.3 7.0 42

Au/5 at. % Si - Annealed 5.9 8.0 43

Au/15 at. % Si 5.9 7.9 48

Au/15 at. % Si - Annealed 3.3 4.3 23

Au/25 at. % Si 5.0 6.2 40

Au/25 at. % Si - Annealed 6.0 7.6 40

Table 4.4: Average roughness values for the pure Au and as-deposited and an-

nealed Au-Si films.

Mechanical properties

Figures 4.18 and 4.19 show the hardness and reduced elastic modulus as a function of Si content.

The data represent the average of five measurements and the error bars correspond to the maximum

and minimum values obtained. The hardness, measured at a normalized contact depth of about

0.10, was approximately 1.1 GPa for the pure Au film and is consistent with the values for Au films

reported in the literature [14, 21, 22]. Hardness increased by approximately 65 - 95% (1.81 - 2.14

GPa) by the addition of 2 - 25 at. % Si, respectively. Due to the large error bars present in the

measurements for the annealed films, no significant effect of the annealing on the hardness could be

identified and therefore heat treatment was not further pursued.

The reduced elastic modulus was also measured at a normalized contact depth of about 0.10,

and found to be about 90 GPa for the pure Au film. This corresponds to an elastic modulus

of approximately 79 GPa, consistent with the bulk elastic modulus of 78 GPa, reported for Au

films [103]. The reduced elastic modulus initially increased to 95 and 110 GPa by the addition of 2

at. % and 5 at. % Si, respectively, after which it decreased to 82 GPa for the Au/25 at. % Si film.

After heat treatment, the reduced elastic modulus increased with increasing Si content from 5 - 25

at. % Si. Currently the cause of this effect is unclear.

After observation of the surface contamination, a new specimen set was prepared to investigate

the effect of carbon contamination on the measurements and to ensure that the change in material
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Figure 4.17: Optical images showing the overall surface roughness and contami-

nation on the surface of the (a) Au/25 at. % Si and (b) Au/2 at. % Si films. AFM

scans indicated that the asperities on the surface of the Au/2 at. % Si film had

heights on the order of 2 - 3 µm.

properties was strictly due to hardening mechanisms resulting from interaction between the co-

evaporated elements. The hardness and elastic modulus results shown in Figures 4.18 and 4.19 will

be compared with the new films to investigate the effect of the contamination.

4.2.2 The effect of Si addition

Surface topography

Figure 4.20 shows AFM images of the surface topography of pure Au and Au films co-evaporated

with 2.5, 6, 13, or 21 at. % of Si. The surface roughness is given in Table 4.5. Each value for

the surface roughness represents the average of 3 measurements. The roughness was found to vary

throughout the Si content range and appears to show no direct correlation between Si concentration

and roughness. The surface roughness for the pure Au film was 3.4 nm Ra and consistent with the

prior set. The roughness increased for all other films from 5.5 - 19.1 nm Ra for the 21 at. % Si and

13 at. % Si films, respectively. The cause of this variation in surface roughness is unclear.

Mechanical properties

Figures 4.22 and 4.23 show the hardness and reduced elastic modulus as a function of the Si content

ranging from 2.5 - 21 at. %. The data represent the average of five measurements and the error bars

correspond to the maximum and minimum values obtained. Some material pile-up was observed for
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Figure 4.18: The effect of Si content and heat treatment on the hardness of pure

Au and Au-Si films.

Figure 4.19: The effect of Si content and heat treatment on the reduced elastic

modulus of pure Au and Au-Si films.
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Figure 4.20: AFM images (1 µm x 1 µm scan size) showing the topography of (a)

the pure Au and Au films co-evaporated with (b) 2.5 at. % Si, (c) 6 at. % Si, (d)

13 at. % Si and (e) 21 at. % Si.
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Specimen Roughness

Ra (nm) Rq (nm) Rz (nm)

Pure Au 3.4 4.2 26

Au/2.5 at. % Si 16.1 20.3 114

Au/6 at. % Si 7.6 9.6 59

Au/13 at. % Si 19.1 24.2 129

Au/21 at. % Si 5.5 7.2 45

Table 4.5: Average roughness values for pure Au films and Au films co-evaporated

with 2.5, 6, 13 or 21 at. % Si.

the Au-Si films at a normalized contact depth of about 0.10, as seen in an indentation profile shown

in Figure 4.21.

Figure 4.21: Image of the profile of an indentation, conducted on the Au/6 at.

% Si film at a normalized contact depth of about 0.10, showing some material

pile-up.

The hardness, obtained at a normalized contact depth of approximately 0.10, of the pure Au

film was found to be approximately 1.2 GPa, and is again consistent with values for pure Au films

reported in the literature [14,21,22]. Hardness was found to increase by about 40 - 80% (1.64 GPa -

2.13 GPa) by the addition of 2.5 and 6 at. % Si, respectively. The hardness increased approximately

102% to 2.41 GPa by the addition of 21 at. % Si. However, the hardness of the Au/13 at. % Si

film was found to increase by only 14% to 1.36 GPa. Originally this was thought to be due to

a non-uniform film deposition but measurements conducted on a second specimen (results given

in Figure 4.22) indicated similar mechanical properties, minimizing this possibility and suggesting
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another unknown phenomenon responsible.

The reduced elastic modulus was also obtained at a normalized contact depth of approximately

0.10, and found to be about 112 GPa for the pure Au film. This corresponds to an elastic modulus

of approximately 100 GPa, consistent with values reported in the literature of 77 - 115 GPa for Au

films [21,99–102]. The reduced elastic modulus is seen to follow a trend similar to the hardness with

increasing Si content.

To investigate the effect of the carbon contamination on the original film properties, both mea-

surements were compared simultaneously and are shown in Figures 4.24 and 4.25. The data com-

pares well, when taking into account the error, for all Si concentrations except 13 at. % Si. The low

hardness observed for this film could be attributed to the relieving of residual compressive stresses,

which became evident after film buckling was observed on approximately 10% of the film surface.

An optical image of the film, shown in Figure 4.26, indicates what is known as a “telephone cord”

buckle which has been reported to occur due to compressive residual stresses in thin films [97]. A

plausible explanation for the loss of film adhesion could be Si diffusion occurring into the Ti ad-

hesion layer leading to the formation of titanium silicide, which has been shown to occur at room

temperature [112]. If the thickness of the 10 nm Ti adhesion layer was small enough to allow for

complete consumption, through reaction with the Si, then the film would be ineffective at providing

adhesion of the Au-Si film to the substrate [113].

A comparison of the measured mechanical properties with those predicted by a simple rule of

mixtures calculation is presented next. The rule of mixtures law specifies that a composite material’s

properties can be predicted by the properties of each phase in the composite, i.e., the matrix (Au)

and the constituent (Si), according to their respective volume fractions [114]. This can be utilized

to estimate the hardness and reduced elastic modulus of the Au-Si films according to the following

equations

H ′
u.b. = HAuVAu + HSiVSi (4.1)

H ′
l.b. = {(VAu/HAu) + (VSi/HSi)}−1 (4.2)

(E′
r)u.b. = (Er)AuVAu + (Er)SiVSi (4.3)

(E′
r)l.b. = {(VAu/(Er)Au) + (VSi/(Er)Si)}−1 (4.4)

where H ′, HAu and HSi are the hardness of the Au-Si film, pure Au film and single crystal Si,

respectively, E′
r, (Er)Au and (Er)Si are the reduced elastic moduli of the Au-Si film, pure Au film

and single crystal Si, respectively, and VAu and VSi are the volume fractions of the co-evaporated Au

and Si, respectively, which can be determined based on their atomic volume and percentages [115].
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Figure 4.22: The effect of Si content on the hardness of pure Au and Au-Si films.

Shown for comparison are the upper and lower bound rule of mixture predictions

obtained from Eqns. (4.1) through (4.4).

The subscripts ‘u.b.’ and ‘l.b.’ represent the upper bound and lower bound of the film properties

predicted by the rule of mixtures, respectively, as given by H.S. Kim [115]. The upper bound of

the rule of mixtures is based upon the assumption, first proposed by Voigt in 1928 [116], that

the constituents undergo the same strain in response to an applied load and is also known as the

iso-strain or Voigt model [115, 117]. The lower bound of the rule of mixtures is based upon the

assumption, first proposed by Reuss in 1929 [116], that the constituents undergo the same stress in

response to an applied load and is also known as the iso-stress or Reuss model [115,117].

It is shown in Figure 4.24 that the hardness is increased to a level above the upper bound of

the rule of mixtures for Au films containing low amounts of Si (2.5 - 6 at. %). This suggests that

an additional mechanism(s) is responsible for the increase in film hardness besides the intrinsic

hardening from the co-deposited Si. The hardness does not continue to increase with increasing Si

content greater than 6 at. % and is seen to lie within the rule of mixtures prediction. The hardness

of the Au/13 at. % Si film is directly at the lower bound suggesting that the material follows the

iso-stress model. However, the optical microscope images showing film buckling suggest that the

relieving of residual compressive stresses and poor film adhesion are responsible for the low measured

hardness.
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Figure 4.23: The effect of Si content on the reduced elastic modulus of pure Au

and Au-Si films. Shown for comparison are the upper and lower bound rule of

mixture predictions (upper and lower bound overlap) obtained from Eqns. (4.1)

through (4.4).

Figure 4.24: Comparison of the hardness of the contaminated versus non-

contaminated pure Au and Au-Si films.
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Figure 4.25: Comparison of the reduced elastic modulus of the contaminated

versus non-contaminated pure Au and Au-Si films.

Figure 4.26: Optical image showing “telephone cord” buckling of the Au/13 at.

% Si thin film. The line at the center of each “telephone cord” buckle is the apex

of the delamination.
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The reduced elastic modulus is seen to decrease below the rule of mixtures prediction as the Si

content is increased.

Theories on the additional mechanism(s) responsible for these observations will be discussed

further in the following sections.

Electrical properties

Four-point probe measurements were conducted on all films and the values measured for the resis-

tivity are shown in Table 4.6. The resistivity of the pure Au film was about 3.18 µΩ-cm, higher than

the values measured for Au films discussed in Section 4.1.2 and the value of 2.35 µΩ-cm reported for

bulk Au [111]. The increased resistivity in these pure Au films, compared to those in Section 4.1.2,

could be due to the slightly higher surface roughness. The resistivity increased nearly linear from

5.58 - 38.15 µΩ-cm as the Si content increased from 2.5 - 21 at. %, respectively. The linear trend in

resistivity is shown in Figure 4.27.

Specimen Resistivity (µΩ-cm) Std. Dev. (µΩ-cm)

Pure Au 3.18 0.01

Au/2.5 at. % Si 5.58 0.01

Au/6 at. % Si 12.00 0.08

Au/13 at. % Si 19.46 0.13

Au/21 at. % Si 38.15 0.13

Table 4.6: Average resistivity values for the pure Au and Au-Si films consisting

of Au co-evaporated with 2.5, 6, 13, or 21 at. % of Si.

Material structure

XRD measurements were performed to determine the crystal structure of the pure Au and Au-Si thin

films and the diffraction patterns are shown in Figures 4.28 through 4.32. The diffraction peaks are

labeled with their equivalent interplanar spacing (also known as the d-spacing), and any identifiable

peaks are also labeled with the respective element and Miller Index (or (hkl) value).

The first diffraction pattern, shown in Figure 4.28, was obtained for the pure Au thin film. The

strong peak located at the angle, 2θ = 38.2◦ corresponds to a d-spacing of about 2.35 Å. This

peak represents the (111) lattice plane for a face-centered cubic (fcc) polycrystalline Au structure

with lattice parameter a = 4.08 Å [118] and is present in the remaining patterns. However, it
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Figure 4.27: The effect of Si content on the resistivity of Au thin films.

Figure 4.28: X-ray diffraction pattern for the pure Au thin film.
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Figure 4.29: X-ray diffraction pattern for the Au thin film co-evaporated with 2.5

at. % Si.

Figure 4.30: X-ray diffraction pattern for the Au thin film co-evaporated with 6

at. % Si.
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Figure 4.31: X-ray diffraction pattern for the Au thin film co-evaporated with 13

at. % Si.

Figure 4.32: X-ray diffraction pattern for the Au thin film co-evaporated with 21

at. % Si.
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decreases in intensity and increases in broadness as the Si concentration is increased. The decrease

in peak intensity indicates a shift in the material’s grain orientation. Peak broadening can occur

due to factors such as instrumental effects, decrease in crystal/grain size and/or due to strain in the

lattice [89].

The average grain size of the films was found to be approximately 51, 17, 18, 18 and 20 nm for

the pure Au and Au-Si films with 2.5, 6, 13 and 21 at. % Si, respectively.

The diffraction patterns indicate that the intensity ratio between the (111) and the (200) Au

peaks, I(111)/I(200) decreases as the Si content is increased, indicating a change from the (111)

orientation to the (200) orientation occurring in the films. A plot of the Au peak intensity ratio

I(111)/I(200) versus Si content is shown in Figure 4.33.

Figure 4.33: Variation of Au peak intensity ratio, I(111)/I(200) with Si content.

A similar decrease in I(111)/I(200) has been reported by Tang et al. [119, 120] for annealed Au

films deposited by electroplating. It was proposed that atom transport occurred, either due to the

heat treatment and/or residual compressive stress gradients, at the boundary of (111) and (200)

grains resulting in the preferential growth of the (200) oriented grains. As I(111)/I(200) decreased, an

increase in the thin film residual compressive stress was also measured. This has also been reported

to occur in evaporated Cu films [121] and sputtered Al films [122].

According to Zhang et al. [123], the difference between stresses in Au grains oriented in the (111)

and (200) planes is ∆σ(111)−∆σ(200) = (18.87−7.91) MPa = 10.96 MPa. If compressive stresses are
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introduced into the film, which for the films investigated in this work could be due to the presence

of Si, the stress difference could lead to large compressive stress gradients at the boundaries of (111)

and (200) oriented grains [123]. Tang et al. [119, 120] reported that these large stress gradients

could cause atom transport to occur at the grain boundary, schematically shown in Figure 4.34.

Thus, it is plausible that this mechanism would lead to growth of (200) oriented grains and explain

the change in I(111)/I(200) observed in the XRD measurements presented here. Furthermore, XRD

measurements indicated an almost exclusive (111) orientation for the pure Au film. Therefore, the

biaxial stresses present from co-evaporation with Si could have been minimized and an increase in

the (200) orientation would have provided a system with minimized energy, due to the lower strain

energy of the (200) plane, and a slip system more favorable for deformation and accommodation of

strain [120].

Figure 4.34: Schematic showing atom transport, in polycrystalline FCC films,

occurring across a grain boundary from a (111) grain to a (200) grain resulting

from a large compressive stress gradient [119].

Unknown peaks were observed in the Au/6 at. % Si and Au/13 at. % Si films which have not

been reported in the literature or the ICDD PDF database. No crystalline Si peaks were observed

in the Au-Si films, suggesting that the Si is amorphous. It has been reported that cooling rates in

liquid-quenched Au-Si can be high enough to allow for near or complete suppression of Si crystal

formation [124].

The reduction in grain size suggests that strengthening in the films can be partially attributed to

the Hall-Petch effect. A plausible explanation for this reduction could be pinning of the Au grains by

the dispersed Si particles, which has been reported to occur in Ta particle strengthened Au films [68]

and Si particle strengthened Al films [62].

The deviation from the hardness increase for a Si content greater than 6 at. % Si, shown in

Figure 4.22, could be partly related to the increase in the (200) orientation. Roy et al. [121] re-

ported a decreased hardness in the (200) planes compared to the (111) planes for evaporated Cu

films. The increased hardness was attributed to stronger elastic constants in the (111) plane. Fur-
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thermore, the increased (200) orientation could also be responsible for the observed decrease in re-

duced elastic modulus. Based on the compliance constants given for Au as S11 = 2.355 x 10−11 Pa,

S12 = −1.0814 x 10−11 Pa and S44 = 2.4096 x 10−11 Pa [103], the elastic modulus of Au can be

predicted for the (111) and (200) planes through the following equation [72]:

Ehkl =
{

S11 − 2
[
(S11 − S12)−

1
2
S44

]
(l2m2 + m2n2 + l2n2)

}−1

(4.5)

where S11, S12, S44 are previously defined and l, m, n are the corresponding direction cosines for each

plane in the cubic lattice. From Eqn. (4.5) the estimated elastic modulus values for polycrystalline

Au are E(111) = 115 GPa and E(200) = 43 GPa. Therefore, it is plausible that the pure Au film

with the preferred (111) orientation would have a much higher reduced elastic modulus and that an

increasing degree of (200) orientation could effectively cause the film’s reduced modulus to decrease,

as shown in Figure 4.23.

The diffraction pattern, shown in Figure 4.32 for the Au/21 at. % Si film, exhibits numerous

intense, unidentifiable peaks which suggest the formation of an unknown crystalline Au-Si phase.

Metastable Au-Si phases have been previously reported throughout the literature and have been

the subject of extensive work [69, 124–138] since the first reported observation by Klement et al. in

1960 [139]. While Au and Si are almost completely immiscible in the solid state [69], Klement et

al. [139] first demonstrated that Au-Si alloys could be formed by rapidly quenching a liquid mixture

(a method known as “splat cooling” [126]) of Au with 25 at. % Si to form a metastable amorphous

Au-Si alloy which crystallized at room temperature. The formation of these phases was attributed

to the high cooling rates and it has been reported that metastable Au-Si phases can form at cooling

rates greater than 106 K/s [140]. According to Liebermann [141], vapor deposition methods such as

sputtering and electron-beam evaporation allow for material cooling rates on the order of 108 K/s and

rates as high as 1010 K/s have been estimated [2], suggesting the feasibility of observing metastable

Au-Si phases in the films investigated here. Two prior studies by Dhere and Loral [134] and Robison

et al. [136] have investigated co-evaporated Au-Si and both reported the observation of metastable

phases.

A detailed summary of the various reported structures of Au-Si phases is given by Ashtikar and

Sharma [137]. There have been a total of nine different types of metastable Au-Si alloys reported,

having cubic (fcc or bcc), orthorhombic or hexagonal type crystal structures [137]. While several

of these reported phases have d-spacings which closely match those measured for the Au/21 at. %

Si film, the experimental data is most consistent with a fcc β-Mn-type structure with a = 6.750 Å,

first reported by Suryanarayana and Anantharaman [129, 142] and later by Gaigher and Van der
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Berg [133]. A comparison of the d-spacings reported for the β-Au-Si phase with those measured for

the Au/21 at. % Si film is shown in Table 4.7.

β-Mn-type Au-Si [129,142] β-Mn-type Au-Si [133] This Work

hkl dcalc. dobs. dcalc. dobs.

100 6.750 6.526 6.67 —

110 4.776 4.677 4.75 —

111 3.897 3.905 3.86 —

200 3.375 3.365 3.33 —

210 3.018 2.976 2.99 3.00

211 2.755 2.750 2.76 2.76

220 2.388 2.385 2.40 2.41

300 2.250 2.250 2.24 2.26

221 2.250 2.250 2.24 2.26

310 2.134 2.137 2.11 2.14 & 2.11

222 1.948 1.948 — —

320 1.872 1.873 — 1.87

321 1.804 1.805 — —

400 1.688 1.708 — 1.71

410 1.637 1.639 — 1.66

322 1.637 1.639 — 1.66

330 1.592 1.590 — 1.61

411 1.592 1.590 — 1.61

Table 4.7: Comparison of the measured d-spacings for the Au/21 at. % Si film

with those reported in the literature for a fcc β-Mn-type structure [129,133,142].

Comparing the experimental values shown in Table 4.7, the data suggests that a metastable Au-

Si phase has formed in this film with a composition similar to the fcc β-Mn-type structure. However,

while the d-spacings were consistent with this structure, the measured intensities did not compare

as well. The most intense peak shown in Figure 4.32, centered at about 2θ = 42.6◦ (d= 2.12 Å) has

not been reported in the literature for Au-Si films. Also, throughout the studies reported for Au-Si

films [142–149], a very strong peak was reported at about 2θ = 40.0◦ (d≈ 2.25 Å) . The intensity

of this peak was fairly weak to medium for the Au/21 at. % Si film. One plausible explanation for
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this lower intensity is that the XRD measurements were conducted after dissociation had already

initiated. The structure and material properties of rapidly cooled samples can depend on the type of

preparation method used [141], suggesting that the unidentifiable Au-Si compound observed in this

study would not be unexpected. Also, Dhere and Loural note that the precise structure is influenced

by local differences in material composition and atomic arrangement, annealing conditions and

cooling rate [134], thus explaining the abundance of different metastable Au-Si structures reported

in the literature.

The metastability of the unknown phase was shown experimentally by performing a second

XRD measurement on the Au/21 at. % Si film after it was stored at room temperature (RT) for

approximately 8 weeks. The second measurement, shown in Figure 4.35, indicates that the unknown

Au-Si phase has almost completely dissociated, as evident by the almost complete dissapearance of

the unidentifiable peaks. The average grain size was found to increase from 20 - 43 nm. The (111)

Au peak has increased in intensity and only two peaks at approximately 2θ = 42.6◦ (d= 2.12 Å) and

2θ = 48.6◦ (d= 1.87 Å) remain. The slight shoulder present at the base of the (111) Au peak (not

labeled in Figure 4.35) could represent the unknown peak located at 2θ = 37.3◦ (d= 2.41 Å) with

lower intensity.

Figure 4.35: X-ray diffraction pattern for the Au thin film co-evaporated with 21

at. % Si, measured after storing the specimen for approximately 8 weeks at RT.

The surface topography and mechanical properties of the film also changed after the storage
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period. The average surface roughness increased by about 30% from 5.5 - 7.2 nm Ra. Numerous

craters, approximately 20 - 100 µm in diameter, were observed with the optical microscope during

the 10th week of the RT storage period. Delamination, which initiated at the edges of the craters,

was observed with the optical microscope during the 14th week of the storage period. Optical

images of the film surface are shown in Figure 4.36. AFM measurements indicated that the film

surface around the craters exhibited a nodular type topography similar to the surface prior to aging.

Johnson and Johnson [69] reported that dissociation of the metastable Au-Si phase into Au and

Si must be accompanied by a volume expansion. Such an expansion could introduce compressive

stresses into the film and thus explain the observation of film buckling occuring at the edge of each

crater [97]. The hardness and reduced elastic modulus, measured at a normalized contact depth of

about 0.10 during the 12th week of RT storage, were found to decrease by approximately 32% from

2.41 - 1.65 GPa and 53% from 88 - 41.5 GPa, respectively.

Figure 4.36: Optical images showing changes in the surface topography including:

(a) the presence of numerous craters on the surface and (b) film delamination

occurring at the edges of the craters of the Au thin film co-evaporated with 21 at.

% Si, obtained after approximately 10 and 14 weeks of RT storage, respectively.

The RT dissociation of metastable Au-Si phases has been reported in the literature. In a study

by Robison et al. [136], 1000 nm thick Au-Si films were prepared by co-depositing Au with 50 at.

% Si and annealed at temperatures of 100 - 250 ◦C for 5 minutes to compare with the as-deposited

films. XRD measurements indicated numerous peaks which matched those previously reported for

Au2Si and it was proposed that the structure was most likely fcc with a = 19.50 Å. The structure

of the co-deposited films was found to be similar to previous work, in which metastable Au-Si films

were prepared by rapid quenching of liquid Au-Si melts. To demonstrate the metastability of the
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Au2Si phase, XRD measurements were conducted on specimens stored for one month at RT under

vacuum. In all specimens, with the exception of the as-deposited specimen, the Au2Si phase was

undetectable and appeared to have dissociated. While only one additional study has been found

showing evidence of a metastable Au-Si alloy formed through co-evaporation [134], only Robison et

al. have reported RT dissociation [136].

The RT dissociation of metastable Au-Si phases has been reported elsewhere, however, the

investigated films were prepared by liquid quenching methods. Johnson and Johnson [69] (with

earlier similar work [150]), reported dissociation of the Au3Si phase (prepared from Au with a Si

content of 4 - 14 at. %) after specimens were stored for 98 to 111 months at RT. The work by George

et al. [124] is the only known reported RT dissociation of an as-deposited metastable Au-Si phase

in an aging time period on the order of that used in this study. In the previously discussed studies,

the dissociation was reported to occur after post-deposition heat treatment, or after a period of

several months at RT [69]. George et al. [124] reported that in liquid quenched Au-25 at. % Si

specimens, Au3Si peaks measured by XRD dissapeared (only peaks from the polycrystalline Au film

were reported, similar to the results shown in Figure 4.35) after RT storage for several weeks.

TEM measurements were performed to investigate the underlying material structure of the Au-Si

films. An image obtained for an Au film with a nominal Si concentration of 25 at. % is shown in

Figure 4.37(a)-(c). Figure 4.37(a) shows the nanocrystalline Au grain structure with a dispersion of

amorphous Si particles. The average grain and particles sizes were found to be about 18 nm and 1

- 5 nm, respectively. The measured average grain size is consistent with XRD measurements for the

as-deposited Au/21 at. % Si film. The selected area diffraction pattern, shown in Figure 4.37(c),

shows strong (111) Au, (220) Au and (200) Au reflections indicating multiple grain orientations as

well as a lack of Si reflection suggesting an amorphous structure. The (220) reflection is reported

to occur at 2θ = 64.6◦ [118], which is outside of the 2θ scan range (25◦ - 60◦) used for the XRD

measurements explaining the lack of detection for those experiments. The Si particles are located

at the Au grain boundaries suggesting that the decrease in grain size, measured by XRD, could be

partly due to pinning from the dispersed Si particles. A high-resolution image of a 3 nm Si particle

at the grain boundary of two (111) oriented Au grains is shown in Figure 4.37(b).

The measured average Si particle size and separation distance were used to estimate the stress

required to displace a dislocation past a line of Si particles, based on the Orowan mechanism. Using

Eqn. (2.8), the shear modulus G, is determined for the Au film from the elastic modulus (determined

from nanoindentation) and the Poisson’s ratio for the Au film [94] by the equation, G = E/2(1+ν)

= 100.5 GPa/2(1+0.43) = 35 GPa [72]. The magnitude of the Burgers vector is estimated from the
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Figure 4.37: Selected TEM images showing the microstructure of the Au-Si film

with a nominal Si concentration of 25 at. %. (a) TEM image showing the nanocrys-

talline grain structure of the Au with approximately 1 - 5 nm diameter Si particles

located at the Au grain boundaries. (b) High-Resolution TEM (HRTEM) image

showing a 3 nm Si particle at the grain boundary of two (111) oriented Au grains.

(c) Selected area diffraction pattern showing multiple Au grain orientations.

61



interatomic spacing of Au, and assuming a hard-sphere model, is equal to the atomic diameter of

Au, 0.29 nm [76]. The average particle radius r and spacing λ are estimated from the TEM image

shown in Figure 4.37 to be about 1.5 nm and 17 nm, respectively. Using Eqn. (2.8), the increase in

yield strength for the Au-Si film resulting from the Orowan mechanism is estimated to be

σOrowan =
(0.13)(35GPa)(0.29nm)

17nm
ln

1.5nm

0.29nm
(4.6)

and from the above equation, σOrowan ≈ 130 MPa. Therefore, HOrowan ≈ 0.4 GPa, where HOrowan

is the predicted hardness increase of the Au-Si film resulting from the Orowan hardening mechanism.

The maximum and minimum Orowan stresses can be determined from the range of Si particle size

and distributions. Eqn. (2.8) predicts that the Orowan stress will be minimum when the Si particle

radius r is minimum and the particle spacing λ is maximum, and from Figure 4.37, are estimated to

be about 0.5 nm and 44 nm, respectively. Similarly, Eqn. (2.8) also predicts that the Orowan stress

will be maximum when the Si particle radius r is maximum and the particle spacing λ is minimum,

and from Figure 4.37, are estimated to be about 2.5 nm and 8 nm, respectively. From Eqn. (2.8),

these values lead to an estimated hardness range, HOrowan ≈ 0.05 GPa - 1.07 GPa.

This estimate predicts that, assuming the same Si content for the TEM specimens as the 21 at.

% Si film investigated by nanoindentation, the increase in hardness due to the Orowan mechanism

would for about 4 - 88% of the overall hardness increase measured for the Au/21 at. % Si film, with

an average increase of 33% (based on the average particle size and spacing).

The estimated HOrowan range indicates that additional mechanisms, such as the Hall-Petch

effect, may be responsible for the measured hardness increase.
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Chapter 5

Conclusions and Proposed Future

Work

5.1 Conclusions

An investigation of the material properties of electron-beam evaporated polycrystalline Au films

and the effect of Si content on the material properties and structure of co-evaporated Au-Si films

has been performed. Atomic Force Microscopy (AFM), nanoindentation and four-point probe were

utilized to investigate the surface topography, mechanical properties and resistivity of these films,

respectively. Furthermore, X-ray Diffraction (XRD) and Transmission Electron Microscopy (TEM)

measurements were performed to investigate the material crystallography and structure.

The conclusions from the polycrystalline Au baseline investigation are:

Variable deposition rate investigation

1. The surface topography of pure Au films was investigated and the surfaces of the films showed

small, uniformly sized nodules. The surface roughness was found to decrease with increasing

deposition rate.

2. The hardness and elastic modulus of the films ranged from 1 - 1.5 GPa and 80 - 130 GPa,

respectively. Both were found to increase with increasing depth of penetration indicating the

effect of the underlying Si substrate.
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The effect of the adhesion layer and heat treatment

1. Surface topography measurements were conducted on as-deposited and annealed Au films

deposited on Ti or Cr adhesion layers and the roughness was about 2.5 - 3.5 nm Ra. Surface

cracks were observed in the annealed Au film with the Cr adhesion layer and it was suggested

that the cracks formed as a result of diffusion of Cr toward the Au film surface, which has

been reported for annealed Au films [96,104,105].

2. The hardness and elastic modulus were found to be about 0.9 - 1.9 GPa and 70 - 100 GPa,

respectively, for all films. The hardness was seen to decrease with increasing normalized contact

depth up to about 0.2, consistent with the indentation size effect. Both hardness and elastic

modulus increased with increasing depth of penetration, at normalized contact depths greater

than 0.2, due to the increased influence of the underlying Si substrate, as expected. Recognizing

the variations associated with the measurements, no significant effect of the adhesion layer and

heat treatment on the hardness or elastic modulus was identified. Pop-in was observed for both

as-deposited and annealed Au films.

3. The resistivity of the films with the Ti adhesion layer was found to be 2.24 - 2.36 µΩ-cm for the

as-deposited and annealed films, respectively, and was consistent with bulk Au values [111].

The resistivity of the films with the Cr adhesion layer increased to 3.39 - 4.36 µΩ-cm for

the as-deposited and annealed films, respectively. The increased resistivity measured for the

annealed Cr adhesion layer specimen was possibly affected by the diffusion of Cr into the Au

film, which has been reported to lead to an increase in resistivity in Au films [96,104,105].

The conclusions from the Au-Si film investigation are:

Initial shakedown experiments

1. The surface roughness was slightly higher than the values measured for the initial Au baseline

films. Unusual peaks and craters were observed on the surfaces of all films which was later

attributed to carbon contamination occurring during the deposition process.

2. The hardness of the pure Au film was found to be about 1.1 GPa and increased by approxi-

mately 65 - 95% (1.81 - 2.14 GPa) by the addition of 2 - 25 at. % Si, respectively. The effect of

heat treatment was investigated, yet due to the large error bars present in the measurements,

no significant effect of the annealing on the hardness could be identified and therefore heat

treatment was not further pursued.
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Secondary investigation

1. The surface roughness was found to vary throughout the Si content range. The surface rough-

ness for the pure Au film was found to be 3.4 nm Ra, consistent with the prior set. The

roughness increased for all other films from 5.5 - 19.1 nm Ra for the 21 at. % Si and 13 at.

% Si films, respectively. There appeared to be no direct correlation between Si concentration

and roughness. The cause of the variation in surface roughness was unclear.

2. The hardness of the pure Au film was found to be about 1.2 GPa and increased by approx-

imately 40 - 80% (1.64 GPa - 2.13 GPa) by the addition of 2.5 and 6 at. % Si, respectively,

and increased approximately 102% to 2.41 GPa by the addition of 21 at. % Si. However,

the hardness of the Au/13 at. % Si film increased by only 14% to 1.36 GPa. The reduced

elastic modulus for the pure Au film found to be approximately 112 GPa. This corresponded

to an elastic modulus of approximately 100 GPa. The reduced elastic modulus was seen to

follow a trend similar to the hardness with increasing Si content. To investigate the effect of

the carbon contamination on the original film properties, both measurements were compared

simultaneously. The data compared well, when taking into account the error, for all Si con-

centrations except 13 at. % Si. The low hardness observed for this film could be attributed

to the relieving of residual compressive stresses, which became evident after film buckling was

observed on approximately 10% of the film surface which has been reported to occur due to

residual stresses in thin films [97].

3. The film resistivity increased nearly linear from 5.58 - 38.15 µΩ-cm as the Si content increased

from 2.5 - 21 at. %, respectively.

4. XRD measurements indicated that the film structure consisted of polycrystalline Au grains

oriented primarily in the (111) plane and secondarily in the (200) plane. No crystalline Si peaks

were observed in the Au-Si films, suggesting that the Si is amorphous. The intensity ratio

between the (111) and the (200) Au peaks, I(111)/I(200) decreased as the Si content increased,

indicating a change from the (111) orientation to the (200) orientation occurring in the films.

A similar decrease in I(111)/I(200) has been reported in the literature [119–122] and attributed

to an increase in the thin film residual compressive stress. It was suggested that a deviation

from the hardness increase observed for a Si content greater than 6 at. % Si was partly related

to the increase in the (200) grain orientation. The average grain size of the films was found to

be approximately 51, 17, 18, 18 and 20 nm for the pure Au and Au-Si films with 2.5, 6, 13 and
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21 at. % Si, respectively. The reduction in grain size suggested that strengthening in the films

could be partially attributed to the Hall-Petch effect. The diffraction pattern for the Au/21

at. % Si film exhibited numerous intense, unidentifiable peaks which suggested the formation

of an unknown crystalline Au-Si phase. The metastability of the unknown phase was shown

experimentally by performing a second XRD measurement on the Au/21 at. % Si film after it

was stored at room temperature (RT) for approximately 8 weeks. The measurement indicated

that the unknown Au-Si surface phase had almost completely dissociated. The average grain

size was found to increase from 20 - 43 nm. The average surface roughness, increased by

about 30% from 5.5 - 7.2 nm Ra and the hardness and reduced elastic modulus decreased by

approximately 32% from 2.41 - 1.65 GPa and 53% from 88 - 41.5 GPa, respectively after 12

weeks of RT storage.

5. TEM measurements, conducted on a Au/25 at. % Si specimen, showed the nanocrystalline

grain structure of the Au, with an average grain size of 18 nm (consistent with the XRD

measurement), with a dispersion of amorphous Si particles approximately 1 - 5 nm in diameter.

From these results, the predicted hardness increase of the Au-Si film resulting from the Orowan

hardening mechanism was estimated to be HOrowan ≈ 0.05 GPa - 1.07 GPa representing

approximately 4 - 88% of the overall hardness increase measured for the Au/21 at. % Si film,

assuming the same Si content for the TEM specimens. The estimated HOrowan range indicated

that additional mechanisms, such as the Hall-Petch effect, may be responsible for the measured

hardness increase.

5.2 Proposed Future Work

1. Determine if a thicker Ti adhesion layer could eliminate the loss of adhesion observed in the

Au/13 at. % Si film and result in an increase in hardness.

2. Further investigate the effect of Si on the Au film properties through a larger concentration

range by preparation of a compositionally graded film with continuous Si content from 0 - 50

at. %.

3. Investigate the modification of Au films by the introduction of Si-Ge particles, through simul-

taneous electron beam evaporation, which has been reported to lead to an order of magnitude

finer dispersion of particles in Al alloy films compared to those with Si alone [63].
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4. Further investigate the metastable Au-Si phase observed in the Au/21 at. % Si film by per-

forming nanoindentation, surface topography, four-point probe and XRD measurements at

more closely spaced time intervals after film deposition.
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Appendix A

Procedure for measuring the

surface topography using the

Atomic Force Microscope

This chapter describes the procedure performed during a set of surface topography measurements

using the AFM instrument (diDimension R© 3100 manufactured by Veeco, Inc.), including the set-up

of the instrument and software, performing the surface scan and analyzing the results. The operating

procedures have been adapted from the Dimension 3100 Series Scanning Probe Microscope Instruc-

tion Manual [151], Scanning Probe Microscopy Training Notebook [152] and the Veeco Command

Reference Manual [153].

A.1 Instrument and software set-up

The NanoScope Dimension 3100 controller, Nanoscope IIIa Scanning Probe Microscope Controller

and the computer system to the right of the instrument are turned on. Next, the toggle switch,

located at the rear of the instrument, is adjusted so that STD is activated.

The NanoScope software is started by selecting the desktop shortcut labeled NanoScope Version

5.30r3.S13. The proper AFM mode of operation is selected by choosing Microscope → Pro-

file → selecting either Tapping or Contact → Load in the Real-time operating window of the

software. Tapping mode was used for all experimental measurements. The software is then inter-

faced with the AFM head by selecting Microscope → Scanner → 1024g.
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A.1.1 SPM parameters

The SPM parameters, which are the most important Z-axis parameter values for correct operation

of the AFM, are specified next. These are selected by choosing Stage → SPM Parameters and

the appropriate values from Table A.1 are specified in the SPM Parameters panel. For further detail

on SPM Parameters, see Section 9.13 of the Veeco Command Reference Manual [153].

SPM Parameters

Sample Clearance: 1000 µm

SPM Safety: 100 µm

SPM Engage Step: 0.417 µm

Load/Unload Height: 2000 µm

SPM Exclusion Limit: 0.00

SPM Exclusion Limit 2: 0.00

Table A.1: SPM parameters panel

A.1.2 Initial scan parameters

The initial scan parameters are then set in the Real-time operating window of the software according

to the values in Tables A.2 through A.6. For the Channel 1 panel, height is specified as the data

type, however additional Channels 2 and 3 can be activated to display a different data type such as

amplitude, current, deflection, frequency, friction, phase, potential or thermal (temperature) [153].

For further detail on the initial scan parameters, see Chapter 3 of the Veeco Command Reference

Manual [153].

A.1.3 Installing the cantilever, cantilever holder and AFM head

After all of the software settings have been correctly specified, the cantilever is installed onto the

cantilever holder. The cantilevers used for the surface topography measurements are the model

RTESP5, also known as TappingMode Etched Silicon Probes (TESP) [152]. The tip number and

date are recorded in the “SPM Tips” laboratory notebook. The tip is placed into the cantilever

mounting groove, using sharp tweezers, flush against the rear edge and centered between the left

and right edges of the groove located on the cantilever holder, shown in Figure A.1, and the spring

loaded probe clip is used to hold the cantilever in place. The cantilever holder is located on the
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Scan Controls

Scan size: 1 µm

X offset: 0.0 µm

Y offset: 0.0 µm

Scan angle: 0.00◦

Scan rate: 0.40 Hz

Tip velocity: 0.800 µ/s

Samples/line: 256

Lines: 256

Slow scan axis: Enabled

Table A.2: Scan Controls panel

Feedback Controls

Z modulation: Disabled

Integral gain: 0.200

Proportional gain: 0.300

LookAhead gain: 0

Amplitude setpoint: 1.00 V

Drive frequency: Determined by Autotune

Drive amplitude: Determined by Autotune

Table A.3: Feedback Controls panel
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Other Controls

Microscope Mode: Tapping

Z limit: 2.064 µm

FM igain: 15.00

FM pgain: 15.00

Illumination: 0

Units: Metric

Color: 13

Engage: 0.970

Tip serial: —–

Serial number: SN5-129-08 (Automatically Entered)

Min. engage gain: 3.00

Parm update retract: Disabled

Table A.4: Other Controls panel

Channel 1

Data type: Height

Data Scale: 100 nm

Line direction: Trace/Retrace

Scan line: Main (Automatically Entered)

Realtime planefit: Line

Offline planefit: None

Table A.5: Channel 1 panel

Drive Feedback Controls

Drive feedback: Disabled

Drive height: 2.209 nm

Drive time: 10.0 ms

Drive setpoint: 0.900

Drive gain: 1.00

Table A.6: Drive Feedback Controls panel
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standard AFM station of the cantilever holder stand, shown in Figure A.2, which allows for easy

operation of the cantilever holder [151].

Figure A.1: Schematic of the AFM cantilever holder. After Reference [151].

Figure A.2: Schematic of the AFM cantilever holder stand. After Reference [151].

Next, the cantilever holder, with the tip facing toward the instrument’s optics, is installed onto

the AFM head by mating the electrical mounting sockets flush with the electrical pins on the bottom

of the AFM head. The AFM head is then installed in the dovetail groove of the main instrument and

properly mounted by turning the screw, located to the right of the groove, counter-clockwise. The

two plugs from the scanner are then connected to the appropriate sockets located on the electronics

box of the main instrument after which the AFM’s laser will activate.
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A.1.4 Aligning the laser

It is then necessary to align the laser on the cantilever tip to ensure proper collection by the pho-

todetector. The laser spot is positioned on the edge of the tip using the X and Y laser control knobs

located on the AFM scanner, shown in Figure A.3. When the laser spot is properly positioned on

the edge of the tip, the Laser Sum Signal should be approximately 2 V [152]. The photodetector

mirror knobs located on the left side of the AFM scanner, shown in Figure A.4, are then adjusted.

When the laser spot is properly positioned, the red spot will be brightly visible at the origin of the

Detector quadrant schematic located in the Vision System window [151].

Figure A.3: Top-view of the AFM scanner head showing the location of the laser

control knobs. After Reference [151].

Figure A.4: Side-view of the AFM scanner head showing the location of the

detector mirror adjustment knobs. After Reference [151].
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A.1.5 Specimen placement

When the laser alignment is complete, the specimen is placed on the instrument’s vacuum chuck.

Before doing so, ensure that the AFM scanner is raised high enough, using the trackball, to allow for

proper clearance, and the vacuum chuck is clean and free of debris. The chuck can be cleaned with

a lint-free cloth and alcohol if necessary. The specimen is placed directly onto the vacuum chuck

and held in place by engaging the “Vacuum” toggle switch on the main Electronics Box [151]. The

stage and chuck are adjusted in the X and Y directions using the Focus Surface command button

and the trackball to properly place the specimen under the AFM tip.

A.1.6 Locating the tip in the Vision System

Before using the optical system to locate the tip, the tip is moved closer to the specimen surface

using the Focus Surface command icon and the trackball, with the bottom left button pressed,

while simultaneously visually confirming tip clearance with the specimen surface. Next, the tip is

located by using the Focus Tip command icon and the adjustment knobs located next to the optics

to the left of the scanner. During this step it is necessary to adjust the illumination within the

Focus Tip control box. When the tip is located in the Vision System window, the cantilever tip is

focused using the trackball, with the bottom left button pressed, and the optical adjustment knobs

are used to align the cross-hairs at the center of the edge of the cantilever tip. OK on the Focus

Tip control box is selected when finished.

A.1.7 Focusing on the specimen surface

The AFM’s Z-stage is then used to focus on the surface of the specimen which will serve to bring

the tip within the correct initial starting vertical position. The Focus Surface command icon is

selected and using the trackball, with the bottom left button pressed, the tip is slowly moved down

in the Z-direction to focus the surface of the specimen on the Vision System. While performing this

step it is again necessary to simultaneously visually confirm tip clearance with the specimen surface

to avoid damaging the AFM tip. OK on the Focus Tip control box is selected when finished.

A.1.8 Auto tuning the cantilever

Finally, the cantilever is tuned to determine its resonance peak and adjust the oscillation voltage to

ensure that the cantilever vibrates properly [151]. The Cantilever Tune command icon is selected

within the software and then Auto Tune is selected to prompt the software to automatically
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perform this procedure, during which, “Tuning. . .” will appear on the screen and disappear when

the procedure is complete [152]. The resonance peak should have a sharp Gaussian profile [151].

When the Auto Tune is complete, the cantilever Drive Frequency and Amplitude are recorded within

the “SPM Tips” laboratory notebook and Quit is selected to close the Cantilever Tune control

box and complete the tuning procedure.

A.2 Performing a surface scan

Once the initial setup of the instrument and software is complete, a surface scan is performed. The

Engage command icon is selected within the software at which time the instrument lowers the

AFM tip to the specimen surface and automatically begins scanning once the surface is detected.

When the scanning begins, the Scope Mode command icon is selected and proper tip tracking is

confirmed by ensuring that the Trace and Retrace scans are similar and have a minimum vertical

separation. The tip tracking can be improved by increasing both the Integral and Proportional

Gains equal amounts by pressing the right arrow key 1 - 3 times in each box. Additionally, the

Setpoint can be increased, again by pressing the right arrow, which will decrease the force from the

cantilever tip applied to the specimen surface [152].

The image of the surface topography is then obtained by first assigning a filename by choosing

Capture → Capture Filename. An additional file note can be added within Capture Filename

control box. OK is selected when finished. The image is captured by selecting the Capture icon.

The Status Bar located at the bottom of the Real-time operating window of the software will display

On when the capture is in progress, Next if the system is waiting for the next complete frame to

begin and Done when the capture is complete.

After the image is captured, it will automatically stored in the temporary !:\ directory and the

system will continue to scan the surface until prompted to stop. At this time, if no additional images

are desired, the tip is secured by choosing the Withdraw command icon to end scanning and secure

the instrument.

A.3 Analyzing the AFM image

Once the scan is complete and the instrument is secured, the image analysis is begun by switching

from the Real-time operating window to the Off-line operating window by choosing the Off-line

icon. The captured image is selected and first processed using an automatic Planefit filter which
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applies a either a 1st, 2nd or 3rd order polynomial fit to the image in both the X and Y directions

to remove tilt, tilt and an arch-shaped bow, or tilt and an S-shaped bow, respectively [152]. For

all images used in this study, a 1st order planefit was applied by selecting Modify → Plane

Fit Auto → XY → Execute → Quit within the Off-line operating window. Next, the image is

processed using a Flatten filter which applies either a 0th, 1st, 2nd or 3rd order polynomial fit to each

scan line to remove image artifacts due to scanner drift, image bow, skips or additional effects which

could have caused vertical offset between between scan lines, respectively [152]. For all images used

in this study, a 0th order planefit was applied by selecting Modify → Flatten → Execute → Quit

within the Off-line operating window.

After the images are filtered, the surface roughness is measured by selecting Analyze→Rough-

ness within the Off-line window at which time the Roughness Analysis window appears. Ra and

Rq are automatically calculated and displayed under Image Statistics within the Roughness Anal-

ysis window. Rz is measured by using the mouse to select the entire image and select Execute, after

which the value is calculated and displayed under Box Statistics within the Roughness Analysis

window.

Once the roughness is measured the analysis is complete and the image is saved and exported

by selecting Utility → JPEG Export. Within the JPEG Export command window, Screen is

selected under Source, Reverse for the Background and the Destination Directory and file to be

exported are specified.
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Appendix B

Procedure for measuring the

mechanical properties by

Nanoindentation

This chapter describes the procedure performed during a set of nanoindentation experiments us-

ing the load-controlled nanoindenter (TriboScope Nanomechanical Test System R© manufactured by

Hysitron, Inc.) interfaced with the AFM system described in Appendix A. The procedure necessary

to install and interface the nanoindenter with the AFM system will be discussed first after which

the procedure for set-up of the Hysitron software and instrumentation will be discussed. The oper-

ating procedures have been adapted from the TriboIndenter R© User Manual [154], Dimension 3100

Series Scanning Probe Microscope Instruction Manual [151], Scanning Probe Microscopy Training

Notebook [152] and the Veeco Command Reference Manual [153].

Topics discussed will include a background on the operation of the Hysitron nanoindenter, the

set-up of both instruments and software 10-12 hours prior to experimentation, performing the pre-

liminary surface scan, the indentation and analysis of the results.

B.1 Background

The nanoindentation experiments were performed on the same instrument as the AFM by replacing

the AFM head with the Hysitron nanoindentation system. Besides the necessary computer, controller

and signal adapter, the main portions of the instrument are the TriboScanner piezoelectric scanner,
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three plate capacitive transducer and indenter. The TriboScanner allows for precise placement of the

indenter on the specimen surface as well as in-situ imaging of the surface before and after indentations

are performed. It operates through a series of piezoelectric ceramic plates that change shape due

to an applied voltage (operating voltage: -185V to +185V) allowing for precise motion in the X, Y

and Z directions with maximum X, Y and Z ranges of 60 µm, 60 µm and 3 µm, respectively [154].

The three plate capacitive transducer is utilized to perform the simultaneous application of the

force and measurement of the indenter’s displacement into the material. The transducer, shown in

Figure B.1, consists of the two outer electrodes, the top and bottom drive plates and the center

pickup electrode, to which the indenter is mounted (such that the force and displacement of the

center plate correspond to the force and displacement of the tip). The transducer measures the

vertical displacement of the pickup electrode, and therefore the indenter tip, by applying an AC

signal, 180◦ out of phase, to the two outer drive plates. The electric potential between the two outer

plates varies linearly and since the AC signal is 180◦ out of phase, the electric potential is equal

to the applied signal at the drive plates and zero at the pickup electrode. The impedance is such

that the output signal from the transducer is equal to the potential of the center pickup electrode.

Therefore, the vertical displacement is measured from this signal and equal to zero at the center

position and varies linearly as the pickup electrode moves toward each drive plate. The transducer

is capable of a maximum vertical displacement of 5 µm with a resolution of less than 1 nm. The

force is applied to the pickup electrode, and therefore the indenter tip, by applying a DC voltage to

the bottom drive plate to create an electrostatic attraction to the center pickup electrode causing

it to deflect toward the bottom plate. The applied vertical force is then measured from the applied

voltage. The system is capable of applying a maximum vertical force of approximately 10 mN with

a resolution of 1nN [155].

Figure B.1: Schematic cross-section of the 1-D three place capacitive transducer.

After Reference [154].
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B.2 Instrument and software set-up - Interfacing the Tribo-

Scope with the AFM system

The NanoScope Dimension 3100 controller, Nanoscope IIIa Scanning Probe Microscope Controller

and the computer system are turned on. It is then crucial at this point to adjust the toggle switch,

located at the rear of the instrument, so that Hysitron is activated. The TriboScanner will not

operate correctly if this step is not completed and there is a risk for damaging both the transducer

and indenter.

Next, the NanoScope software is started by selecting the desktop shortcut labeled NanoScope

Version 5.30r3.S13. The proper nanoindentation mode of operation is then selected by choos-

ing Microscope → Profile → STM - hys → Load in the Real-time operating window of the

software. The software is then interfaced with the Hysitron TriboScope head by choosing Micro-

scope → Scanner → SN5-129-08.

B.2.1 SPM parameters

The SPM parameters, which are also the most important Z-axis parameter values for correct op-

eration of the nanoindenter, are specified next. These are selected by choosing Stage → SPM

Parameters and the appropriate values from Table B.1 are specified in the SPM Parameters Panel.

For further detail on SPM Parameters, see Section 9.13 of the Veeco Command Reference Man-

ual [153].

SPM Parameters

Sample Clearance: 100 µm

SPM Safety: 100 µm

SPM Engage Step: 0.139 µm

Load/Unload Height: 2000 µm

SPM Exclusion Limit: 0.00

SPM Exclusion Limit 2: 0.00

Table B.1: SPM parameters for proper nanoindenter operation
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B.2.2 Initial scan parameters

The initial scan parameters are then set in the Real-time operating window of the software accord-

ing to the values in Tables B.2 through B.5. In the the Scan Controls panel, the Scan size is

initially set to 0.00 nm and therefore the tip velocity will initially be 0.00 µ/s. The Integral and

Proportional Gains are set to 2.00 and 3.00, respectively, in the Feedback Controls panel when

performing nanoindentation experiments. Additionally, only one channel is activated when using

the nanoindenter. For further detail on the initial scan parameters, see Chapter 3 of the Veeco

Command Reference Manual [153].

Scan Controls

Scan size: 0.00 nm

X offset: 0.0 µm

Y offset: 0.0 µm

Scan angle: 0.00◦

Scan rate: 1.00 Hz

Tip velocity: 0.00 µ/s

Samples/line: 256

Lines: 256

Slow scan axis: Enabled

Table B.2: Scan Controls panel

Feedback Controls

Current setpoint: 1.00 nA

Integral gain: 2.00 µm

Proportional gain: 3.00 µm

Table B.3: Feedback Controls panel

B.2.3 Cleaning and installing the indenter tip

Prior to installing the indenter to the transducer, it is necessary to clean the diamond tip. This is

done by removing the tip from the transducer (or from the storage case if not installed) and wiping

the surface of the tip with a lint-free lens tissue which has been saturated with a 70%/30% mixture
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Other Controls

Z limit: 2.064 µm

Illumination: 0

Units: Metric

Color: 13

Tip serial: —–

Serial number: SN5-129-08 (Automatically Entered)

Min. engage gain: 3.00

Parm update retract: Disabled

Table B.4: Other Controls panel

Channel 1

Data type: Height

Data Scale: 100 nm

Line direction: Trace/Retrace

Realtime planefit: Line

Offline planefit: None

Table B.5: Channel 1 panel
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of methanol/ethyl alcohol. The saturated tissue, which is held using a pair of locking forceps, is first

carefully wiped in a single direction across the tip using the top side of the tissue and then wiped

in the opposite direction using the bottom side of the tissue. The tip is then washed directly with

the methanol/ethyl alcohol mixture and immediately dried using ultra high purity N2 gas.

The tip is then placed into the tip holder, with the threaded end facing out, and placed on the

threads of the transducer. Before tightening the tip onto the transducer threads, it is necessary

to first ensure that it is not cross-threaded by turning counter-clockwise until a slight click is felt.

Next, holding the tip holder with two hands, the tip is slowly threaded into the transducer until a

slight pressure is felt. During this step it is crucial not to apply pressure toward the transducer (the

center pickup electrode in which the indenter is mounted to is extremely fragile) or over-tighten the

indenter tip. When the indenter is properly installed onto the transducer, the tip holder is carefully

removed.

B.2.4 Installing transducer and TriboScanner

For all nanoindentation experiments used in this study, a 1-D transducer was used capable of mea-

suring the normal force and vertical displacement of the tip. The transducer is then installed onto

the dovetail of the TriboScanner and the small hex screw located on the side of the transducer is

tightened to firmly secure it in place. It is connected to the scanner by plugging the electrical cable

from the transducer to the right 15-pin female socket located on the top of the TriboScanner. Before

installing the TriboScanner, it is necessary to ensure that the Z-stage of the AFM is completely

raised to allow for adequate clearance for the scanner. The TriboScanner is then installed in the

dovetail groove of the main AFM system, and properly mounted by turning the screw, located to

the right of the groove, counter-clockwise. The scanner is then connected to the Dimension R© 3100

AFM system by plugging in the male electrical cable, coming from the top of the scanner between

the two 15-pin female plugs, into the electronics box of the AFM system. Next, the male transducer

controller cable is plugged into the left 15-pin female socket located on the top of the TriboScanner.

After all of the proper electrical connections have been established between the transducer,

TriboScanner and the instrument electronics, the transducer controller is turned on. When the

controller, shown schematically in Figure B.2, is turned on the green power indicator LED should

illuminate and the LOAD (mg) LCD will initially display a value of -1 and the DISPLAY GAIN

will need to be decreased to 1. With the equipment properly installed, the LOAD (mg) LCD should

now show the reading of the load applied to the transducer due to the weight of the tip and be
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approximately 266.1 mg. The other settings of the transducer controller are as follows: LOW PASS

FILTER: 300 Hz, OUTPUT 1 GAIN - DISPLACEMENT: 1000, OUTPUT 2 GAIN - MICROSCOPE

FEEDBACK: 1000 and DISPLAY GAIN: 10. After the initial LOAD value has been checked, the

display is set to zero by first pressing AUTO ZERO and then using the FINE or COURSE MANUAL

ZERO knobs to zero the load value in the LCD.

Figure B.2: Schematic of the front panel of the nanoindenter transducer controller.

After Reference [154].

B.2.5 Locating the indenter tip in the Vision System

The tip is located within the AFM Vision System by using the Focus Tip command icon and the

adjustment knobs located next to the optics to the left of the scanner. During this step it is necessary

to adjust the illumination within the Focus Tip control box. The Vision System will show a side

view of the indenter with the tip pointed to the right of the image. When the indenter tip is located

in the Vision System window, the tip is focused using the trackball, with the bottom left button

pressed, and the optical adjustment knobs are used to align the cross-hairs slightly to the right of

the tip. OK is selected on the Focus Tip control box when finished.

B.2.6 Specimen placement

When the indenter has been located in the Vision System, the specimen is placed onto the instru-

ment’s vacuum chuck. Before doing so, ensure that the TriboScanner is raised high enough, using

the trackball, to allow for proper clearance, and the vacuum chuck is clean and free of debris. The

chuck can be cleaned with a lint-free cloth and alcohol if necessary. The specimen is placed directly

onto the vacuum chuck and held in place by engaging the “Vacuum” toggle switch located on the

main Electronics Box [151]. The stage and chuck are adjusted in the X and Y directions by using

the Focus Surface command button and with the trackball to properly place the specimen under

the indenter tip.
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B.2.7 Manual approach

The AFM’s Z-stage is then used to bring the tip closer toward the specimen surface. To perform this

task, the secondary illumination switch located on top of the transducer control box is turned on, then

the Focus Surface command icon is selected and using the trackball, with the bottom left button

pressed, the tip is slowly moved down in the Z-direction until the secondary illumination becomes

visible on the Vision System and the tip becomes visible via the AFM’s optical system. While

performing this step it is again absolutely necessary to simultaneously visually confirm indenter

clearance with the specimen surface to avoid damaging the indenter tip. The manual approach is

continued until a reflection of the indenter tip (tip pointed to the left) appears from the right side of

the Vision System window. At this point the tip should be about less than 1 mm from the surface

of the specimen and the approach is stopped. The Z-stage motion is deactivated by choosing OK

on the Focus Surface control box and the secondary illumination is turned off.

B.2.8 Thermal equilibration

Once the tip is brought to roughly 1 mm from the specimen surface, the transducer controller and

vacuum chuck are turned off and the thermal enclosure of the instrument is secured. The entire

instrument and specimen are allowed to thermally equilibrate for 10-12 hours, typically overnight,

before the experiments are begun.

B.3 Instrument and software set-up - Hysitron system

After the thermal equilibration period is complete, the thermal enclosure is opened, the vacuum

chuck is turned on to secure the specimen and the enclosure temperature and humidity are recorded.

This process should take approximately less than 10 seconds. Next, the transducer controller is

turned back on and the LOAD LCD checked and zeroed. The secondary illumination is again

turned on and the Focus Surface command icon is selected and the trackball is used to carefully

bring the indenter tip to within less than 100 µm of the specimen surface. During this step, the

indenter reflection on the right side of the vision screen will slowly approach the real image of the

indenter to the left until it is a distance of about the width of the cross-hairs in the center of the

screen. At this point, the tip is within the proper placement from the specimen surface and the

remaining approach is controlled by the AFM system. The Focus Surface control box is then

closed and the illumination turned off. The system is allowed to re-thermally equilibrate again for
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about 1 hour to overcome the effects of opening the enclosure. During this waiting period, set-up of

the Hysitron software necessary to begin the experiment is completed.

The Hysitron software is opened by selecting the desktop shortcut labeled TriboScope3.5FL, on

the computer system to the left of the instrument, prompting the Data Analysis window to appear

on the screen. The Setup Indent icon is selected to open the Load Function window. It is then

necessary to check if the proper transducer constants file is installed which matches the transducer

to be used for the experiments. This is done by selecting the Set Transducer Constants icon

and confirming that the file name in the Transducer Constants box matches the serial number of

the transducer installed on the instrument. The transducer constants used for the experiments

performed in this study are given in Table B.6. See the TriboIndenter R© User Manual [154] for more

discussion on Transducer Constants.

Z-axis

Load Scale Factor (mV/mg) 1.00

Displacement Scale Factor (mv/µm) 100

Electrostatic Force Constant (µN/V2) 0.02800 - 0.03000

Machine Compliance (nm/mN) 1.50

Maximum Force (µN) 10296.00

Displacement Gain 1000

Table B.6: 1-D transducer constants

Prior to beginning each set of indentation experiments, while the indenter tip is still positioned

less than 100 µm from the surface of the specimen, a procedure known as an air-indent is performed

to properly adjust the Electrostatic Force Constant. To set up this procedure, the air-indent loading

function is opened on the software by selecting File → Open and choosing the saved air-indent

load function. The load pattern consists of a uniform 4 second loading up to a peak load of 20 µN

followed by a 4 second unloading to zero load. The Spring Force Compensation is turned on, which

corrects the forces resulting from deflection of the transducer’s center pickup electrode [154]. This is

done by selecting Setup → Spring Force Compensation. Also, 2,000 data points are specified

for the loading pattern.
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B.4 Performing the indentation

B.4.1 The air-indent

After the 1 hour period is complete, the load on the transducer controller is again zeroed, if necessary,

and the first air-indent is completed. When finished, the .hys file is saved and the Data Analysis

window again appears showing the Load versus Displacement data for the completed indentation.

If the Electrostatic Force Constant is properly set, then the load-displacement data will appear as

an increasing displacement at a constant zero load. If not, then the Electrostatic Force Constant is

adjusted by selecting the EDIT icon and adjusting the Electrostatic Force Constant by increments

of 0.00005 - 0.00010 µN/V2 until the load-displacement curve maintains an increasing displacement

at a constant zero load. When the new Electrostatic Force Constant is chosen, it is adjusted in the

Transducer Constants box by selecting the Set Transducer Constants icon in the Load Function

window. The transducer controller load is again zeroed, if necessary, and the procedure is repeated

until the air-indent results in the proper load-displacement curve.

Once the air-indent procedure has been completed the load pattern is changed to that shown in

Figure 3.1. The number of data points are changed to 8,000 and the desired load is adjusted. Also,

the software is set up to measure the thermal drift rate over a 5 second interval and confirm that it

is less than 0.1 nm/s. If a higher drift rate is detected, the system will re-measure the thermal drift

rate over repeated 5 second intervals until it is less than the user specified 0.1 nm/s. The drift rate

is specified by selecting Setup → Drift Correction and Turn On is checked.

B.4.2 The preliminary surface scan

Prior to beginning the indentation, the TriboScanner, in conjunction with the AFM system, is used

to perform a preliminary scan of the surface. This is done by re-zeroing the transducer controller load

and selecting the Engage command icon within the AFM software at which time the instrument

automatically lowers the TriboScanner to the specimen surface and begins scanning with the indenter

tip once the surface is detected by the transducer. When the scanning begins, the scan size is changed

to 1 µm and the Scope Mode command icon is selected and the Scope Trace is used to confirm

if the tip is tracking properly. During scanning, the center pickup electrode of the transducer

is adjusted to properly center it between the two outer drive plates by choosing Motor → Step

Motor and selecting Tip Down button to slowly raise the pickup electrode, in 0.139 µm increments,

until the Voltage shown in the Scope Trace window decreases to between -15 V to + 15 V. After a
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full scan is complete and the surface quality is confirmed, the Scan Size, Integral and Proportional

Gains are all set to zero causing the scanner to disengage and allow the Hysitron system to gain

control of the instrument.

B.4.3 The indentation

When the Scan Size, Integral and Proportional Gains have been set to zero, the Manual Indent

icon is selected in the Load Function window of the Hysitron system. At this point, the instrument

applies the specified load function and performs the indentation. When the indentation is complete,

the tip is secured on the AFM system by selecting the Withdraw command icon, within the

AFM software, to automatically withdraw the indenter and secure the scanner. The Integral and

Proportional gains are then set back to 2.00 and 3.00, respectively, and the specimen stage is moved

50 µm in the X-direction to the location for the next indent. The indentation .hys file is then saved.

B.4.4 Analysis of the results

Once the indentation data has been saved on the Hysitron computer, the load-displacement curve

will automatically open in the Data Analysis window. The measured hardness H, reduced elastic

modulus Er, contact depth hc and material stiffness S can then be obtained from the curve using the

Hysitron software. For the experiments used in this study, the measured load versus displacement

data were instead analyzed using the computer program, Indentation Data Analyzer (IDA), devel-

oped by M. Klopfstein [86]. This software has the advantage over the instrument’s in that it allows

the user the option to determine the thermal drift rate from the hold period at 10% of max load

and to use this value to correct the measured data. Additionally, it incorporates correction factors

to the procedure developed by Oliver and Pharr [77]. See the IDA Help file [86] for more specific

information on these correction factors.

In the Data analysis window, the necessary steps are taken to export the data for analysis in

the IDA program. First, the Drift Correction is turned off by selecting the Edit icon and de-selecting

Drift Correction under Current Parameters within the File Calibration Constants window

and then selecting OK. The data is then exported as a .txt file under the same filename by selecting

the Export Tab Delimited Text icon in the Data Analysis window. The Drift Correction is

then turned back under on under Current Parameters within the File Calibration Constants

window.

Next, the IDA software is opened by selecting the desktop shortcut labeled Indentation Data
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Analyzer(IDA) on the same computer system. Within the main software window, 0.00 is entered for

the Frame Compliance Cf and the Upper and Lower Fits are set at 95% and 20%, respectively, as they

are in the Hysitron software. The Upper and Lower Fits correspond to the portions of the unloading

curve that will be analyzed. Additionally, the Berkovitch B5 indenter, used for all experiments, is

selected under Indenter. The Advance Parameters are then specified by selecting File → Setup

More Parameters. In the Advance Parameters window, if the material’s Poisson’s ratio is

known (as in the case of the pure Au specimens) then Gamma Correction can be applied with the

known Poisson’s ratio specified. The boxes labeled Compute drift rate and Calculate creep rate

are selected which will prompt the software to determine the respective values from the exported

Hysitron experimental data. The drift rate was determined during the last 40 seconds of the hold

period at 10% of the peak load, i.e., start (sec) = 125 and end (sec) = 165. The end time of the drift

rate calculation is 5 seconds after the end of the hold period specified in the load function. This is to

correct for a lag time of approximately 5 seconds added by the Hysitron software to the experimental

data. All other default software functions are left unchanged. See the IDA Help file [86] for more

specific information on the Advanced Parameters used in this software. Next, the load profile shown

in Figure 3.1 is chosen by selecting File → Select Loading Profile → Five segment loading.

The correct times for each segment are also specified for the five segment load profile. The exported

data from the Hysitron software is then chosen as the Input File by selecting File → Open and

choosing the appropriate input file. The output file is specified by selecting File → Select output

file name and choosing an existing file to overwrite or writing the new output file name in the box

labeled “Filename:”. The data analysis is then completed by selecting Analyze. After the software

has completed the data analysis, the calculated values are displayed on the right side of the main

screen and the results are summarized in the box in the bottom right corner.

At this time, the procedures described in Sections B.4.2, B.4.3 and B.4.4 are repeated and a total

of five indentations are completed at each chosen contact depth.
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Appendix C

Procedure for measuring the thin

film resistivity using the

Four-Point Probe method

This chapter describes the procedure performed during a set of resistivity measurements using the

four-point resistivity probe instrument (FPP-5000 manufactured by Veeco, Inc.) including the initial

setup and performing the measurement. The operating procedures have been adapted from the FPP-

5000 Four Point Resistivity Probe: Installation, Operation and Manual [87].

C.1 Initial setup

Before beginning the measurements, the instrument’s platen is adjusted to ensure that the probes

are at the proper distance from the specimen. To adjust the platen, the circular adjustment tool is

placed onto the platen so that it is located over the probe pins and the platen aperture, as shown

in Figure C.1. Next, the platen is pressed down until it reaches the stop and the adjustment screw,

located at the front/center of the platen, is turned either clockwise or counterclockwise to lower or

raise the platen, respectively. The adjustment is performed only until the outer probe pin makes

contact with the underside of the adjustment tool.

Next, the instrument is turned on by toggling the power switch located on the left rear of the

instrument. The film thickness is first stored in the instrument by pressing SLICE, PGRM,

entering the thickness of the film in either units of mils or µm (the default unit is mils), pressing
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Figure C.1: Schematic showing the proper placement of the platen adjustment

tool. After Reference [87].

the STORE button and again PGRM to exit. The geometric correction factor (if needed) is then

stored by pressing SHEET, PGRM, entering the appropriate geometric correction factor, pressing

the STORE button and again PRGM to exit. The SLICE button is then pressed to set the

instrument in the proper mode to perform a resistivity measurement.

The instrument uses a standard 3 in. wafer holder in which to secure the specimen during

measurements. All specimens used in this study were cleaved to various sizes and therefore it was

necessary to mount them onto standard Si wafers using double-stick tape. The specimen and wafer

are placed face down onto the black plastic wafer holder and the backing plate is placed on top with

the rubber, spiral side facing down. The backing plate is divided into four quadrants labeled ‘2’ - ‘5’

which are used to center the wafer holder on the platen. The entire assembly is carefully placed onto

the instrument platen and with the quadrant arm labeled ‘2’ facing down, the horizontal quadrant

arms labeled ‘3’ and ‘5’ are lined up with the white horizontal marker lines on either side of the

platen. This ensures that the specimen is properly centered over the probe pins.

C.2 Performing the measurement

To measure the resistivity, the top cover is slowly closed onto the backing plate which will cause the

platen to lower until the specimen makes contact with the probe pins. When contact is established,

the instrument will click and the test will begin at which time the electronic display will go blank

and the TEST indicator next to the display will illuminate for approximately 2 seconds. When the

measurement is completed, the TEST indicator will darken and the display will read the measured

resistivity. The cover is then opened and the wafer holder and backing plate are rotated until the
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quadrant arm labeled ‘3’ is facing down and ‘2’ and ‘4’ are horizontal. The procedure is then repeated

until the wafer holder and backing plate have rotated 360◦ for a total of four measurements.
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